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Chapter 1

Introduction
Introdu
Welcome to Neo, the latest computing solution from AlphaSmart. 
Neo is the easy to use, portable, and affordable computing answer for 
students, writers, researchers, and professionals on the go. Neo 
provides a wide range of computing capability on its own, and 
integrates effortlessly with your desktop or laptop computer. 

With Neo, you can comfortably write, edit, and store text quickly and 
conveniently, no matter what your location. Neo’s light weight and 
long battery life make it an easy choice to use at school, the library, in 
meetings, or out in the field.

Neo comes with AlphaSmart Manager software, the companion 
application that runs on your computer (PC or Macintosh) and lets 
you manage and configure your Neo. AlphaSmart Manager merges 
the ease and convenience of Neo with the power and depth of your 
personal computer.

Note: This manual is geared toward users of individual Neos. If 
you’re using a group of Neos with an AlphaHub (for example, the 
SmartOption Bundle from AlphaSmart), consult the AlphaSmart 
Manager 2 User’s Guide for more detailed information about using 
AlphaSmart Manager in group settings.
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Why use Neo?
Why use Neo?
With Neo you’ve got a solution that is

• Simple. Just turn it on and start typing; turn it off when you’re 
done. Everything is saved as you type. With its built-in 
AlphaWord™ Plus word processor, you can write stories, capture 
brainstorming ideas, take notes or minutes, and more. Then you 
can easily transfer the information to any computer or printer 
with a single keystroke.

• Flexible. You can customize Neo to suit your varying needs. You 
can control the screen contrast level on Neo’s large, easy-to-read 
display. And you can choose a font size in AlphaWord Plus that 
lets you work comfortably no matter where you are or what you’re 
working on. You can also set file sizes so that your Neo works the 
way you do.

• Infrared-compatible. Neo comes with a built-in IrDA® port for 
sending text or printing to infrared-enabled devices. 

• Rugged and portable. Neo is built to endure. Its design ensures 
it can be toted to classrooms, board rooms, seminars, on 
vacation, or virtually anywhere, without damage. Its light weight 
and extra long battery life make it an invaluable tool.

• Expandable. Neo comes standard with the AlphaWord Plus 
word processor, Calculator, and Control Panel SmartApplets. You 
can purchase and install other optional SmartApplets (software 
programs specially designed for Neo) to support your needs. For 
example, you can buy SmartApplets that help you learn to type, 
easily outline material, let you take quizzes, and more. 

• PC and Macintosh compatible. Neo works with both Macintosh 
and PC computers. 
Neo User’s Guide
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System requirements
System requirements
Neo works with Macintosh or PC desktop or laptop computers that 
have an external USB keyboard or USB port. 

• Macintosh. Neo is compatible with any Macintosh computer 
running OS 9.0 or higher. 

• PC. Neo is compatible with any PC running Windows 98 (Second 
Edition) or higher. (Windows NT does not support USB.)
ction 3
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Chapter 2

Basics
Basics
This section gives you basic information about getting your Neo up 
and running as quickly as possible. Details about using the various 
features of your Neo are described in the rest of this manual.

The main things you’ll probably want to do to begin using your 
Neo are

• Provide power to your Neo

• Enter text into your Neo

• Connect your Neo to a computer

• Send your text to a computer

• Print from your Neo

• Install AlphaSmart Manager software on your computer

• Set up infrared capabilities (optional)

A table at the end of this chapter shows the types of sending, 
printing, and other tasks you can do using a USB cable versus infrared 
technology.

Powering your Neo
Before using your Neo, you must provide power to it. Depending on 
the model you have, you either install AA batteries, or you connect 
the AC adapter and charge the internal battery pack.
5
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Powering your Neo
Note: If your Neo uses AA batteries, and you’d like it to be 
rechargeable instead, you can purchase a rechargeable battery 
upgrade kit from AlphaSmart. See the AlphaSmart web site for 
more information.

Important: If you purchased a rechargeable Neo, or have converted a 
Neo to be rechargeable, charge it as soon as possible after you receive it. Do 
not store it without first charging the batteries. See the task below for 
information about how to charge a rechargeable Neo. Also see 
page 131 for more information about rechargeable Neos.

To install AA batteries:

1. Make sure you have three new AA batteries. 

2. Turn your Neo over and locate the battery compartment.

3. Using a Phillips screwdriver, unscrew the Phillips screw securing 
the battery compartment. 

4. Open the battery door by placing your thumbs in the depressions 
on the ends of the latch, then gently press down and slide the 
latch to the left.

5. Insert the three batteries with the (+) terminals pointing to the 
right and the (–) terminals pointing to the left.

6. Replace the latch and slide it gently to the right.

7. Replace the Phillips screw and tighten gently.

To charge a rechargeable Neo:

1. Connect the AC adapter to your Neo and plug the cord into a 
working electrical outlet.

2. Let the unit charge for 16 hours (for a first time charge) or 4–8 
hours (for subsequent charges) before disconnecting the AC 
adapter cord. 
Neo User’s Guide
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Entering text into your Neo
Note: You can begin using your Neo while it’s charging, but you 
should let the unit charge completely before disconnecting it. 
Neo’s indicator light (on the upper right edge) turns green when 
it’s fully charged.

Important: Complete information about batteries, including critical 
information about rechargeable batteries, is detailed in 
“Understanding Batteries” on page 129. Consult this section of the 
manual to ensure maximum battery life with your Neo. 

Entering text into your Neo
It’s easy to enter text into your Neo.

To enter text:

1. Turn on Neo by pressing on/off. A message appears briefly that 
tells you what workspace you’re in. (If you don’t have a blank 
screen in which to type, refer to the following section.)

2. Begin typing. Your text appears on the screen. 

3. Use the arrow keys (I J K L) to move your cursor in the text.

4. Press backspace to erase the character to the left of the cursor; 
press delete to erase the character to the right of the cursor.

There is no need to save your text. It’s automatically saved in the 
current workspace while you type. To begin another document, press 
one of the other file keys (2 through 8) along the top edge of the 
keyboard.

My screen isn’t blank
If you turn on your Neo and the screen isn’t blank, it usually means 
that someone else has used the device before you (which is quite 
likely if you didn’t purchase the device yourself but are using it in a 
7
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Entering text into your Neo
group setting). If the screen isn’t blank, it probably means one of 
three things: 

• Your Neo is in the SmartApplets menu.

If your screen looks like the illustration above, use the arrow keys 
to select AlphaWord Plus and press enter.

• The device could be in the AlphaWord Plus SmartApplet but 
already have text in one or more of the files.

If this is the case, press one of the file keys until you find an 
empty workspace in which to type.

• The device is in another SmartApplet, such as Calculator.

If this is the case, press the applets key to return Neo to the 
SmartApplets menu. From there, use the arrow keys to select 

file 1 file 2 file 3 file 4 file 5 file 6 file 7 file 8
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Connecting your Neo to a computer
AlphaWord Plus and press enter. You might need to press one of 
the file keys along the top of the device to find an empty file.

Connecting your Neo to a computer
Neo connects easily to any USB-compatible computer—Macintosh 
or PC—using a standard USB cable. 

To connect your Neo to a USB computer:

1. Plug the thin rectangular end of the USB cable into the 
computer’s USB port (either on the CPU, on a USB hub, or on 
some USB keyboards). 

2. Connect the smaller, squarish end of the cable into the computer 
port along Neo’s top edge. (The computer port has a small 
computer icon to its left.) 

3. On a PC, you might be prompted to install a driver the first time 
you connect your Neo to the computer with a USB cable. If 
prompted, step through the screens that appear, accepting the 
default values presented, and then reboot the computer. This 
step doesn’t apply to Macintosh computers.

To the
computer
USB port

To the
Neo 

computer port

The USB cable for connecting to USB computers
9
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Sending text to a computer
Successfully attaching your Neo
When you attach your Neo to a computer, Neo automatically changes 
modes to prepare to transfer data and the screen displays one of the 
following messages: 

As soon as you’ve successfully connected your computer to Neo, you 
can send text to your computer.

Sending text to a computer
Depending on your computer’s capabilities, you can send text from 
your Neo to your computer using either a USB cable or infrared (IR) 
beaming technology. (Your computer must be IR-capable to accept 
beamed text.) You can send text to any application that accepts text.

Sending text when connected by a USB cable
Sending text by means of a cable is quick and simple. 

Macintosh:

PC:

If you don’t see the appropriate message, check your cable and make sure 
it’s attached properly to the computer. 
Neo User’s Guide
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Sending text to a computer
To send text to a computer:

1. On your computer, open the file to which you want to send the 
text (it can be a new file or a file that already has text), and place 
your cursor where you want the text to begin. 

Note: AlphaSmart Manager must be closed. Otherwise, you won’t 
be able to send text to the application on your computer.

2. Turn on your Neo and make sure you’re in the file you want to 
send.

3. Connect your Neo to your computer as described in “Connecting 
your Neo to a computer” on page 9.

4. Press send. Neo displays a progress bar and a percentage of how 
much text has transferred. 

5. When the transfer is complete, simply unplug Neo from your 
computer. 

6. On your computer, save the file. 

7. If you don’t want to keep the file on your Neo, press clear file, 
then press Y for yes. If you do want to keep the file on Neo, then 
do nothing.

You can send additional files from Neo while still attached to the 
computer. 

To switch between files while connected: 

1. On your Neo, press -file 1 to go to File 1, -file 2 to go to File 2, 
and so forth. 

2. Press send.

3. Save the file on your computer. 

You can also use AlphaSmart Manager to send text to your computer 
when connected by USB cable. See “Working with AlphaSmart 
Manager” on page 87 for more information.
11
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Sending text to a computer
Sending text with IR beaming
If you want to use infrared beaming with your Neo, see “If you want to 
use IR” on page 16 for directions on how to set it up. (The section 
also contains a table comparing what you can do with a USB 
connection and what you can do with IR.) You must have an 
IR-capable computer and install AlphaBeam™ (page 17) before you 
can beam text to your computer.

It’s easy to use IR to transfer files. The steps outlined here describe 
how to use AlphaBeam, which is included on the CD that came with 
your Neo.

To beam text to a computer:

1. Turn on your Neo and make sure you’re in the file you want to 
send.

2. Start the AlphaBeam application on your computer.

3. Point the infrared lens of the Neo toward the IR transceiver.

4. On your computer, open the file to which you want to send the 
text (it can be a new file or a file that already has content), and 
place your cursor where you want the text to begin. This should 
be the last thing you do before going to step 5. This ensures your 
application is the active window and ready to receive text.
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Sending text to a computer
5. Press send on Neo. The AlphaBeam application shows that it’s 
retrieving text, and text appears in your open file.

If it looks like nothing happened, it might be that AlphaBeam was the 
active window rather than your application. Try one of these two 
solutions:

• The text you sent should be on your computer’s clipboard, so all 
you might need to do is paste it into your application. On your 
computer, from your application’s Edit menu, choose Paste.

• On your computer, again make sure the application you want the 
text sent to is the active application (the last one you clicked in). 
In Neo, send your text again.

AlphaBeam

Text transferred 
by AlphaBeam 
into an 
application
13



14

Printing from Neo
Printing from Neo 
While many users prefer to print their AlphaWord Plus files from their 
computer after sending them from Neo, others might want to print 
directly to a printer without the intervening steps.

Neo can print to many USB printers and can also print by beaming 
text to an IR-capable printer. To find out about using IR technology to 
print, see “If you want to use IR” on page 16.

To print from your Neo to a USB printer:

1. Plug the thin, rectangular end of the printer’s USB cable into 
Neo’s USB printer port, located along Neo’s top edge on the left.

2. Make sure the other end of the USB cable is plugged into the 
printer.

3. Make sure the printer is turned on. 

4. Press -P or print on Neo to print the current file. 

Note: Neo doesn’t control print settings such as font, print 
quality, margins, and so on. These settings are determined by the 
printer’s default settings. 

To beam text to a printer:

1. Make sure your Neo is turned on and that you’re in the file you 
want to print.

2. Point your Neo at the printer’s IR transceiver and press print.

Installing AlphaSmart Manager
AlphaSmart Manager is a software application you install on your 
computer to help manage files, SmartApplets, and settings on your 
Neo. Neo can be used alone with your computer and a USB cable or 
IR pod, but AlphaSmart Manager offers a convenient way to view, 
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Installing AlphaSmart Manager
collect, and transfer files back and forth between your Neo and your 
computer.

To install AlphaSmart Manager:

1. Put the AlphaSmart Manager CD in the CD drive on your 
computer. A window displaying the contents of the CD appears.

2. Do one of the following:

• Macintosh: Double-click the AlphaSmart Manager Installer 
icon.

• PC: Double-click the Setup.exe file.

The installation program begins.

3. Follow the onscreen instructions.

4. Indicate if you want to search for configuration files from 
previous versions of AlphaSmart Manager. You can have the 
installer help you locate these files or browse for them yourself.

5. Choose whether to find and update any existing SmartApplets 
you might have on your computer. You can have the installer help 
you locate these files or browse for them yourself.

Important: AlphaSmart Manager will need to update the 
SmartApplets on your computer, so that you can use them with the 
updated system files on your Neo. 

6. Step through any remaining installation steps.

7. Choose whether to view the ReadMe file and/or start AlphaSmart 
Manager as soon as the installer closes.

To learn about using AlphaSmart Manager, see “Working with 
AlphaSmart Manager” on page 87.
15
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If you want to use IR
If you want to use IR
With IR technology, you can transfer the contents of your Neo to a 
suitably equipped computer or printer without using cables. Neo can 
be up to three feet (one meter) away while transferring text to and 
from a computer or printer.

Neo has a built-in infrared module that conforms to IrDA industry 
standards. If the receiving computer or printer has a built-in IR 
transceiver, or an attached IR pod, you can send text by “beaming” it 
from Neo.

To beam with your Neo, you must have one of the following:

• AlphaBeam software for your computer. AlphaBeam lets you 
beam from Neo to your computer. AlphaBeam comes with your 
Neo and is located on the AlphaSmart Manager CD.

• Get Utility 3.2 or higher software for your computer. With Get 
Utility you can beam files back and forth between your Neo and 
computer. You can purchase Get Utility from the AlphaSmart web 
site.

• Beamer SmartApplet for your Neo. Beamer doesn’t beam to a 
computer or printer, but it does let you beam text between two 
Neo User’s Guide



Basics

If you want to use IR
AlphaSmart devices. You can purchase Beamer from the 
AlphaSmart web site.

See the following sections for more information. 

AlphaBeam 
AlphaBeam is a software application you install on your computer 
that lets you beam text from your Neo to an IR-capable computer. 
AlphaBeam comes with Neo, and you can always download the latest 
version from the AlphaSmart web site.

Warning! If you’re going to use a USB wireless pod as the transceiver, 
don’t connect it to your computer until after you’ve completed 
installing AlphaBeam.

To install AlphaBeam:

1. Insert the AlphaSmart Manager CD into the CD drive on your 
computer and navigate to the Extras\AlphaBeam folder.

2. Do one of the following:

• Macintosh: Double-click the AlphaBeam Installer icon.

• PC: Double-click the Setup.exe file.

3. Step through the installation screens to complete the 
installation.

4. When prompted, restart your computer.

Get Utility
Get Utility is an application you can purchase from AlphaSmart that 
lets you transfer files between your computer and your Neo using 
either a USB cable or IR beaming. In fact, using Get Utility is the only 
method that lets you transfer data from your computer using IR 
beaming.
17
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If you want to use IR
For complete information about Get Utility, refer to the ReadMe file 
that accompanied the application or visit the AlphaSmart web site.

Beamer SmartApplet
Beamer SmartApplet is a SmartApplet you can buy from AlphaSmart 
to install on your Neo. It uses IR technology to beam data between 
two AlphaSmart devices (such as two Neos or a Neo and an 
AlphaSmart 3000) or between an AlphaSmart device and a Palm OS 
device (such as Dana by AlphaSmart).

Beamer doesn’t let you beam between your computer and your Neo, 
but it’s a convenient and quick way to share AlphaWord Plus files 
between two Neos. With Beamer, you can press ctrl-send in 
AlphaWord Plus to beam an AlphaWord Plus file (and ctrl-B to 
receive) from one Neo to another, provided both Neos have Beamer 
installed.

For more information about Beamer, visit the AlphaSmart web site.

Adding IR technology to your computer
If you want to send text using IR technology, but your computer 
doesn’t have built-in IR capabilities, you can purchase an IR pod 
from the AlphaSmart web site.

If your printer doesn’t have infrared capability, you can add this type 
of functionality to it. Visit the AlphaSmart web site or contact your 
printer manufacturer for information about IR printer pods.
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USB cable versus IR technology
USB cable versus IR technology
The following table summarizes the tasks you can accomplish with 
the USB and IR connection methods.

Task USB cable IR

Send Neo files to your 
computer

Yes, with the 
send key or 
AlphaSmart 
Manager

Yes, with either 
AlphaBeam or 
Get Utility

Send files from your 
computer to your Neo

Yes, with 
AlphaSmart 
Manager or Get 
Utility

Yes, with Get 
Utility

No, with 
AlphaBeam

Install SmartApplets Yes, with 
AlphaSmart 
Manager

No

Manage settings from 
your computer

Yes, with 
AlphaSmart 
Manager

No

Send AlphaWord Plus files 
between AlphaSmart 
devices

No Yes, with 
Beamer 
SmartApplet 
(purchase from 
the AlphaSmart 
web site)

Print files from Neo Yes, with a USB 
printer

Yes, with an
IR- capable 
printer
19
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Neo User’s Guide



Chapter 3

All About AlphaWord Plus
All Ab
AlphaWord Plus is the most widely used SmartApplet on Neo. This 
chapter describes the features of AlphaWord Plus. The topics 
explained are

• Entering and editing text

• Understanding workspaces and files

• Formatting text

• Changing the onscreen font size

• Finding text

• Checking spelling

• Using the thesaurus

• Counting characters, words, and more

• Using linked files

• Maintaining your files

Entering and editing text
When you start AlphaWord Plus for the first time, Neo places you in 
the workspace for file 1, which is empty. The next time you start 
AlphaWord Plus, Neo places you in whatever file you last worked on 
before you turned the device off. The cursor is in the same position in 
the file exactly as you left it.
out AlphaWord Plus 21
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Entering and editing text
If you want to work in a different workspace, select it by pressing one 
of the file keys (file 1–file 8) at the top of the keyboard. 

When you’re in the appropriate file, to enter text, simply begin 
typing. Use backspace or delete to erase. 

Note: There’s no need to save your file; Neo saves each character 
as you type it.

Consult the following tables for information on how to move through 
your file, select text, and cut/copy/paste/delete text.

Moving the cursor

Note: As with most word processors, text automatically wraps at 
the end of each line. Press enter only when you want to separate 
paragraphs. 

Press To move

I J One character to the left or right

K L One line up or down

-K Up one screen (scrolling)

-L Down one screen (scrolling)

-I Beginning of line

-J End of line

option-I or option-J Previous word or next word

ctrl-I or ctrl-J Previous sentence or next sentence 

ctrl-K or ctrl-L Previous paragraph or next paragraph

home Beginning of file

end End of file

file 1 file 2 file 3 file 4 file 5 file 6 file 7 file 8
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Entering and editing text
Selecting text
When you select text on your Neo, the selection appears highlighted 
in reverse; that is, text within a selection is light and the background 
is dark. To deselect a selection, press esc or an arrow key. (Cutting, 
copying, and pasting also deselects a selection.) 

Cutting/Copying/Pasting/Deleting text
To cut, copy, or paste text, you must first select it (see the previous 
table).

Press To select

shift-I One character to the left at a time

shift-J One character to the right at a time

shift-K One line up

shift-L One line down

shift-option-I From cursor to beginning of word

shift-option-J From cursor to end of word

shift- -I From cursor to beginning of line

shift- -J From cursor to end of line

shift-home From cursor to beginning of file

shift-end From cursor to end of file

ctrl-A or -A Entire file

Press To

ctrl-X or -X Cut selected text to the clipboard

ctrl-C or -C Copy selected text to the clipboard

ctrl-V or -V Paste text from the clipboard into 
your file
out AlphaWord Plus 23
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Entering and editing text
Note: Neo has a built-in clipboard, like most computers. The 
following section provides details about using the clipboard.

Using the clipboard

The clipboard is a place where you temporarily store data to reuse in 
another area. When you use cut and copy commands, you’re placing 
text on the clipboard. When you use the Paste command, you’re 
pasting text from the clipboard into a file.

You can view information about the clipboard—either contents or 
status—at any time.

To view the clipboard contents:

1. Press ctrl-option- -C. If the text on the clipboard is lengthy, you 
can use the arrow keys to scroll the text.

2. Press esc to return to your file.

To view the clipboard status:

1. Press option- -C. The screen displays the number of text pages 
currently in the clipboard and how much empty space is still 
available.

2. Press any key to exit the status screen and return to your file.

Note: You can paste the contents of the clipboard to a new 
location in the current file, or anywhere in a completely different 
file. The clipboard can store only one block of text at a time. 

backspace Delete a character to the left of the 
cursor or delete a text selection 

delete Delete a character to the right of the 
cursor or delete a text selection

clear file Remove the entire contents of the file

Press To
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Understanding workspaces and files
AlphaWord Plus makes use of workspaces—eight of them—one for 
each file key along the top of keyboard. 

In AlphaWord Plus, you’re always in one of the eight workspaces, 
which you use for your work in progress. When you press one of the 
file keys in AlphaWord Plus, the associated file immediately opens. If 
there is no file associated with the file key you pressed, then you have 
a blank space in which to create a new file. 

These workspaces give you instant access to your text—either text 
you’ve just typed, or a file you worked on before that you’ve named. 
By simply pressing the file keys, you switch instantly between 
whatever files or text are loaded into the workspaces.

Just because you have eight workspaces doesn’t mean you’re limited 
to eight files only. You can name your files, move them out of a 
workspace, then swap them back in when you’re ready to work on 
them again. 

Creating files
The first time you start up AlphaWord Plus, it places you in File 1 (the 
workspace associated with the file 1 key). After that first time, the last 
file that you used opens whenever you start AlphaWord Plus. 

To create a file:

X In AlphaWord Plus, press the file keys until you find an empty 
workspace and begin typing.

There is no need to save your work, because Neo saves each 
character as you type it. (You can, however, “save” your file in order to 
give it a name. See “Formatting text” on page 28 for more 
information.) 
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Understanding workspaces and files
To create a new file in a workspace that contains text:

1. Press the file key for the workspace you want to work in.

2. Press ctrl-N. AlphaWord Plus asks whether you want to keep the 
existing text in the workspace. 

3. Do one of the following:

• Press Y if you want to save text, then type a name for the text. 
AlphaWord Plus saves the text as a file with the name you 
specified, then clears the workspace so you can begin your 
new file.

• Press N if you don’t want to save the existing text. AlphaWord 
Plus removes the text so you can begin your new file.

Naming and saving files
At any point when you’re working on a file, you can stop and name it.

To name and “save” a file:

1. From within the file you want to name, press ctrl-S.

2. Type a name for the file and press enter.

Finding files
To edit a file, you have to locate it first. 

To locate a file you want to edit:

1. Do one of the following:

• Press the appropriate file key if you know which workspace the 
file is in.

• Press ctrl-F to use the File Selector. The File Selector lists the files 
on Neo and displays part of the first line of text in each file. (As 
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you scroll the list, the workspace number or file name is 
displayed on the top line.)

• Press ctrl-O to use the Open File feature. Open File lists the files 
by name (if they’re named) or by workspace (if they’re not 
named). An asterisk indicates the active workspace.

2. Use the arrow keys to select a file, then press enter.

3. Do one of the following:

• If the file you selected already occupies another workspace, 
you’ll see a message that tells you to press the enter key to 
open the file in its currently occupied workspace. Press enter. 

• If the file you selected does not currently occupy another 
workspace, and if the current workspace has unnamed text in 
it, you’re asked if you’d like to keep the current file. If you 
choose Yes, you can give the file a name and press enter. The 
file you selected in step 2 then appears in the workspace.

Note: If the workspace contained a named file, AlphaWord Plus 
swaps it out of the workspace and replaces it with the file you 
selected. The named file is saved and you can see it in the File 
Selector or File Open.

List of files 
displayed by the 
File Selector

List of files 
displayed by 
Open File
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Formatting text
Neo lets you concentrate on the content of your text rather than its 
layout. Formatting—such as margins, fonts, and style attributes—are 
more conveniently performed on your computer (with its larger 
screen and mouse) after you transfer text from your Neo. Only the 
characters themselves (ASCII key codes) are transferred from Neo to 
the computer. 

You can, however, change the size of the screen font on your Neo. 
See “Changing font size” on page 28 for details.

Using tabs
You can use tab to create columns or paragraph indents in your file. 
Tabs in a file appear as either a tab space between characters or as a 
tab space with a right arrow between characters, if you turned on the 
Show Marks feature. For more information about tabs and the Show 
Marks feature, see “Show Marks” on page 68.

Changing font size
You can change the onscreen font size in AlphaWord Plus on your 
Neo. Changing the font size changes how text appears onscreen 
while in AlphaWord Plus, letting you work at a screen size that suits 
your needs. It doesn’t change font attributes associated with the text, 
so when you send text to your computer or printer, the text itself is 
plain text.

There are six font settings from which to choose:

• System (four lines per screen using a fixed width font)

• Small (six lines per screen)

• Medium (five lines per screen)

• Large (four lines per screen)
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• Very large (three lines per screen)

• Extra large (two lines per screen)

When you change the font size, that change applies to all files and 
workspaces in AlphaWord Plus. You can’t set different font sizes for 
different files. If, for some reason, some of the font sizes are removed 
from your Neo (either deliberately or accidentally through 
AlphaSmart Manager), AlphaWord Plus defaults to the four-line 
system font.

The following illustrations show examples of the font sizes.

Extra large (two lines)

Very large (three lines)

Large (four lines)

Medium (five lines)

Small (six lines)
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Changing font size
You can set the font size in one of three ways:

• By using a keyboard command.

• Through the Control Panel SmartApplet (see “Control Panel” on 
page 64 for more information about Control Panel).

• Through AlphaSmart Manager. Note, however, that AlphaSmart 
Manager can only reset the font size to the system font (four lines 
onscreen).

To set the font size:

1. Do one of the following:

• Press ctrl-option- -F.

• Press applets and select Control panel; then, scroll to select 
Change default SmartApplet font from the list of options.

2. Scroll to select the font size you want to use, then press enter.

If you changed the font size with the keyboard command, you’re 
returned to the workspace where you were working previously. If you 
used Control Panel, you’re returned to the list of settings. Press 
applets, then select AlphaWord Plus to view the change in font size.

The system font

The four-line system font is slightly different from the four-line large 
font setting. The four-line system font is a “fixed-width” or 
“monospace” font, and the four-line large font is a proportional font. 
With fixed-width fonts, every character and space occupies the exact 
same width. With proportionally spaced fonts, each character 
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occupies only the space it needs to display that particular character. 
So, for example, an m character takes up more space than an i 
character. This illustration shows the difference between Neo’s four-
line fonts:

Finding text
There are a few ways to find text within AlphaWord Plus:

• You can search for a text string within a file or across all files

• You can search and replace text within a file

• You can view a list of sections in a particular file. Sections are 
separated by paragraph returns, and the section selector displays 
the first line of each paragraph.

Searching for text
In AlphaWord Plus, you can search for text within the current file or 
within all files. If you want to both search and replace text, you can 
do so in the current file only.

Large four-line font 
(proportional)

System four-line font 
(fixed width)

Note the different widths of the words “William,” “ill,” and 
“lollipop” in each illustration
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Finding text
To find text:

1. Press find or -F.

2. Type the text you want to find. (If you previously searched for 
text, press clear file to remove your earlier entry before typing the 
new text you want to find.)

3. Do one of the following:

• Press enter to search within the current file.

• Press option-enter to search within all files.

4. To exit the Find screen without searching, press esc.

If the text string is found, the cursor appears at the beginning of the 
string. If Neo can’t find the text you entered, you see a brief message 
that the text is not found. 

To find the same text again:

X Press -G.
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To find and replace text:

1. Press ctrl-find. The Find/Replace screen appears.

2. Type the text you want to find in the Find field, then press tab or L 
to move to the Replace field. (If you previously searched and 
replaced text, press clear file to remove your earlier entries.)

Tip! You can use the clipboard to paste text into both the Find 
and Replace with fields.

3. Type the replacement text. 

4. Press tab or L, then I J to move between options for the 
search:

• Whole word. Searches for complete words only. If you don’t 
select this option, it searches for characters that may be part 
of a longer word or part of more than one word (for example, 
searching for hat would find that, chat, and hatchet).

• Match case. Finds text that exactly matches the 
capitalization of the text you typed in the Find field.

• Replace all. Specifies that you want to replace all 
occurrences within the file.

5. Press spacebar to select or deselect search options.
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6. Press enter to begin the search. The following screen appears 
when AlphaWord Plus finds the word you specified.

7. Do one of the following:

• Type R to replace the found string with the replacement 
string.

• Type S to skip that occurrence of the found string.

• Press the arrow keys to scroll the surrounding text so you can 
see the found string in the context of nearby text.

• Press esc to exit without finding or replacing any other 
strings.

Tips on finding text

Keep these tips in mind when searching your files:

• You can search and replace up to 100 characters, including 
spaces.

• Unless you specify otherwise, a search is not case sensitive, so if 
you are looking for CAT and type cat, the search finds cat, CAT, Cat, 
or caT, and so on. 

• If you don’t restrict the search to whole words (the default) 
AlphaWord Plus also finds partial words or characters embedded 
in other words. For example, if you search for cat, it also finds 
catalog.
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• If password protection is enabled on your Neo (see page 78 for 
information), you won’t be able to search within all files using 
option-enter.

• You can search in all files, but you can search and replace in the 
current file only.

Section selector
In AlphaWord Plus, a “section” is a block of text separated by one or 
more blank lines. You can find and move to areas of text by 
displaying the beginning line of each block, as shown in the following 
illustration:

To view sections in a file:

1. Press -S. A list of sections in your file appears.

2. Use the arrow keys to scroll to the section you want, then press 
enter to move to the beginning of the section you chose.

Defining section separations

In the section selector, you can specify the number of blank lines 
between text to constitute a section. For example, you might not 
want each paragraph to be its own section, but would rather have 
higher level topics be sections. In your document, you could separate 
paragraphs by one carriage return, and topics by two or more. Then 
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Checking spelling
when you go to search by section, you would see only the topics as 
sections, as in this illustration:

To define section separations: 

1. Press -S. 

2. Type a number between 1 and 9 to define the number of blank 
lines between sections.

3. When prompted, type Y to change the section separator to the 
number you specified, or type N to leave the number as it is.

Checking spelling
Neo comes with a spell check feature that offers suggestions for 
corrections. 

How sections might 
appear when blank lines 
are set to two

An example of how you 
might format your file in 
AlphaWord Plus
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To spell check a file:

1. Press spell check. Spell check begins checking each word in your 
file. If it finds a word that doesn’t exist in its dictionary, a 
suggestion screen appears, as in the example shown here (which 
found the word “runn” in the file).

2. Do one of the following:

• Use the arrow keys to select the correct word from the list of 
suggested spellings and press enter.

• Press I to ignore the word and go on to check the next word.

• Press E to edit the word. At the prompt that appears, type the 
new word you want and press enter to make the change. 

• Press C to see the word in context. You can’t make changes to 
the misspelled word while viewing it in context. To exit from 
this mode, press any key.

• Press A to add the word to the user dictionary.

• Press esc to exit spell check.
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Checking spelling
If you haven’t exited spell check by pressing esc, when it finishes 
checking your file, it displays a message that the spell check is 
complete and returns you to your file.

Spell check tips
Use these tips to streamline your spell checks:

• You can spell check a selection within a file. This can be useful if 
you have a long document and want to check only a portion of it 
at a time. To spell check a selection, select the area and press 
ctrl-spell check.

• You can globally replace a word you frequently misspell with the 
correct spelling. For example, if you routinely type teh for the, 
when spell check catches this mistake, press ctrl-enter to replace 
all instances of teh with the in your file.

• You can ignore all occurrences of a word that spell check flags as 
misspelled. This saves you from having to press a key to ignore 
the word each time it’s found. This is a useful way to bypass 
custom terms or proper names. When you’re spell checking a 
document and spell check questions a properly spelled word not 
in its dictionary, press ctrl-I to ignore all instances of that word in 
the file.

Tip! You can create your own custom user dictionary for 
AlphaWord Plus. See “User dictionary” on page 39 for details.

Turning off spell check
You might have times when you want to turn off spell check. You can 
turn it off (and turn it back on) in one of three ways:

• From Neo, using a keyboard command (explained below)

• From Neo, using the Control Panel SmartApplet (page 64)

• From AlphaSmart Manager, by disabling it (page 110)
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For the first two methods, you’ll need to enter a master password. For 
information on master passwords, see “Neo password protection” on 
page 77. 

To disable or enable the spell checker:

1. Press option- -spell check.

2. Type the master password and press enter.

Tip! If you’re using a group of Neos and an AlphaHub, use 
AlphaSmart Manager to disable or enable the spell checker on all 
devices in one operation.

User dictionary
If you have a list of custom words that regularly trip up your spell 
checks—scientific terms, proper names, acronyms—you might want 
to create your own list of words—a user dictionary—to add to the 
AlphaWord Plus dictionary.

You can add words individually to your Neo, using either the Spell 
Check settings in Control Panel or the Add option within a spell 
check. However, the most efficient way to add words is to create a text 
file on your computer, then use AlphaSmart Manager to send the list 
to your Neo. 

There can be only one user dictionary on Neo. You can add individual 
words to it (through Control Panel or within a spell check), but you 
can’t delete words within the user dictionary. 

Consequently, it’s a good idea to keep a master list of words as a text 
file on your computer. You can add or delete words to this list as 
often as you like, then resend the list to your Neo. When you send 
over a new list, it overwrites the existing user dictionary on the 
device. (You can also delete the user dictionary entirely, either from 
AlphaSmart Manager or on the device itself.)
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Using the thesaurus
Steps for sending a user dictionary to Neo using AlphaSmart 
Manager are detailed in “Sending a user dictionary to Neo” on 
page 118.

Using the thesaurus
Keeping writing lively and interesting can be a challenge, and a 
skillful writer knows how useful a thesaurus can be. AlphaWord Plus 
on Neo comes with a thesaurus as a standard writing tool. Using the 
thesaurus, you can look up a word and select a synonym or antonym 
to replace it.

To use the thesaurus:

1. From within the file you want to work with, press ctrl-T. The 
Thesaurus screen appears.

2. Type the word you want to look up. (In your file, if the cursor is at 
the beginning or within a word, AlphaWord Plus automatically 
places the word in the text field. Press clear file to remove it.)

3. Press enter. One of two possible screens appears:

• If the word could not be found in the thesaurus, you can 
press enter to look up a different word or esc to exit.
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• If the word was found, you’re prompted to pick a category (or 
part of speech), as shown in the illustration below.

4. Scroll using the arrow keys to select the category, then press 
enter.

5. When you settle on the word you prefer, scroll to select from the 
synonyms AlphaWord Plus presents, then press enter.

6. Use the arrow keys to scroll and select one of the following 
options:

• Replace a selection in the file

• Copy the word you chose to the clipboard (ctrl-C) so you can 
paste it elsewhere

• Begin a new lookup in the thesaurus for the word you 
selected

Depending on what you choose, you’re either returned to your file or 
to the thesaurus.

Antonyms
You can also use the thesaurus to look for antonyms, words that 
mean the opposite of the word you’re looking up. Press A when 
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you’re prompted to select a category or synonym to view antonyms 
to your lookup word.

Spanish-English word lookup
You can replace Neo’s thesaurus with a Spanish-English word lookup 
utility. The word lookup operates the same as the thesaurus, but you 
type in Spanish words to find their English equivalents.

Note: You can’t have both the English thesaurus and the 
Spanish-English word lookup installed on a Neo. 

If you find you’re not using the thesaurus and want to replace it with 
the word lookup, you use AlphaSmart Manager to remove the 
thesaurus and install the word lookup in its place. See “Replacing the 
thesaurus with the Spanish-English word lookup” on page 120 for 
details. Once you’ve installed the word lookup, follow the steps 
described here to type a Spanish word and find its English 
equivalent.

To use the Spanish-English word lookup:

1. In AlphaWord Plus, press ctrl-T. The word lookup (labeled 
Thesaurus) appears.

2. Type the Spanish word you want to look up and press enter. 
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3. Use the arrow keys to select the category of word you want to look 
up and press enter.

4. Use the arrow keys to select the English word you want to use 
and press enter. (If you don’t see the word you want, you can 
press L to look up additional words or C to return to the category 
list.)

5. Use the arrow keys to select whether to place the word in the file, 
copy it to the clipboard, or begin a new lookup search.

Character, word, paragraph, and 
page counts
It’s often handy to know the length of the file you’re working on. In 
AlphaWord Plus, you can quickly view a screen that lets you know 
how many characters, words, paragraphs, and pages the current file 
contains.
out AlphaWord Plus 43



44

Character, word, paragraph, and page counts
To view a file’s length:

1. Make sure you’re working in the file whose length you want to 
check.

2. Press ctrl-W. The following screen appears, displaying statistics 
for your particular file.

3. Press M to view additional statistics; scroll to view all 
information available.

4. Press esc to exit the screen and return to your file.
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Using linked files
AlphaWord Plus supports linked files, that is, files that you connect 
to AlphaWord Plus files.

A linked file is a place to store additional information related to a file. 
You could create a linked file that outlines the writing you plan to do, 
displays a checklist of tasks to accomplish, consists of vocabulary 
words, contains rubric information, and more.

A linked file is read-only. You can’t create or edit linked files in 
AlphaWord Plus. You create them on your computer, enclosing the 
text within special tags, and send them to AlphaWord Plus using 
AlphaSmart Manager or Get Utility. 
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Using linked files
When you’re in a linked file, you view it by toggling between it and 
the AlphaWord Plus file with which it’s associated. Here’s an example 
of a simple linked file that lists vocabulary words:

To create a linked file:

1. Start a word processing application on your computer.

2. Create a new file. 

3. Type <FORM>. Be sure to include the angle brackets (greater 
than and less than “arrows”) around the word.

4. Enter the text you want for the linked file.

5. Add checkbox controls (if you like) or formatting to your linked 
file. (Refer to the table on page 50 for information about the 
types of tags you can use and what they do.)

Linked file on Neo

AlphaWord Plus file 
on Neo

Linked file source in AlphaSmart 
Manager
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6. End the linked file by typing </FORM> .

7. If you want to add text that will appear in the main file, add it 
either before the beginning <FORM> tag or after the 
ending </FORM> tag. If you don’t want any text in the main file, 
skip this step.

8. Save your work, if you want to use this linked file again or make 
changes to it in the future.

9. If you’re ready to send the linked file to your Neo, select all text 
and copy it to your computer’s clipboard (usually with 
ctrl-C or -C).

To send a linked file to your Neo:

1. Start AlphaSmart Manager on your computer and connect your 
Neo.

2. Click the AlphaWord Files to Send tab.

3. Select the workspace where you want to send the linked file. 

4. Paste the text for the linked file into the File # text area. (If you 
didn’t copy the linked file text to the clipboard, you can drag it to 
the area, or type directly in the area using the appropriate tags.)
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5. If you want to send any text for the main AlphaWord Plus file, 
insert it before or after the text for the linked file (that is, before 
or after the <FORM> tags).

6. Click the Send list tab to verify the linked file and any other text 
appears as you want it, then click Send.

The linked file and any other associated text are sent to your Neo. 
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To view a linked file:

1. On your Neo, press the appropriate file key with which the linked 
file is associated.

2. Press ctrl-L. The linked file appears.

3. Press ctrl-L again to return to the main file.

Tips for using linked files
Here are a few tips to think about when working with linked files:

• If you send a workspace file to your computer using send, and 
that file has a linked file associated with it, the text of the linked 
file is also sent.

• You can print just linked file text. Simply press ctrl-L to view your 
linked file, then press print on your Neo. Whatever is onscreen 
when you press print—the text of a main file or the linked file 
text—is what is sent to your printer when you press print.

• If you’re viewing a linked file and no longer want to work with it, 
you can return to the main file by pressing ctrl-L or by pressing 
the file key for that workspace. You can also exit the linked file by 
pressing a different file key or by pressing applets to go to the 
SmartApplets menu.

• You can copy the text of a linked file and paste it into the main 
file or into another workspace. To do so, view the linked file by 
pressing ctrl-L, the press shift-ctrl- -C. The linked file is copied to 
the clipboard. Then, press ctrl-L to return to the main file, or 
press one of the file keys for a different workspace, then press 
ctrl-V to paste the text.

• If you have Beamer SmartApplet, you can type the linked file tags 
and text you want to use for a linked file in AlphaWord Plus, then 
beam it over to another Neo. The receiving Neo accepts it as a 
linked file. Both devices must have Beamer installed on them.
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Tags for linked files
The tags that you use for linked files are similar to HTML tags. Most 
have a beginning tag enclosed in angle brackets (<tag>) and an end 
tag enclosed in angle brackets with a forward slash (</tag>). The 
following table lists the tags you can use in linked files.

Working with linked file controls

The controls in a linked file are very simple to use. When viewing a 
linked file, you can check checkboxes by pressing spacebar or X, and 
clear them by pressing spacebar or backspace. Move forward through 
checkboxes by pressing tab; move backward by pressing shift-tab. If a 
linked file is lengthy, you can use the arrow keys to scroll it.

Tag Description

<FORM> Begin a linked file

</FORM> End a linked file

[] or [ ] Insert a checkbox

<PRE> Begin a preformatted section (use this 
when you want to precisely control line 
breaks)

</PRE> End a preformatted section

<NOBR> Begin no break text (use this to keep the 
text that follows on a single line, if 
possible)

</NOBR> End of no break text

<BR> Insert a hard return
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A sample linked file

Below is a sample of a more complex linked file, shown as you’d 
create it on your computer and how it appears on an AlphaSmart 
device. 

Story Starter
The assignment is to write a story.  Every story 
has four parts: a setting, characters, a plot, and 
a solution. Press ctrl-L to view the steps to 
complete. Write your story in the first person 
and begin with one of the phrases below.

I never noticed...
I remember...
I felt...
I saw...
<FORM>
Complete each step:
<br>
[ ] Choose a setting
[ ] Choose characters
[ ] Choose a plot
[ ] Choose a solution
</FORM>

An example of a linked file you 
might create on your computer

Line break

Editable text that 
appears in the 
main file

Text and 
checkboxes that 
appear in the 
linked file
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Maintaining your files
There are no tricks to maintaining your files in Neo. The following 
sections explain some basic ideas about file maintenance.

File size
You can change the minimum and maximum limits on file size using 
AlphaSmart Manager. See the chapter “Working with AlphaSmart 
Manager” on page 87 for additional information.

Complete each step:

[ ] Choose a setting
[ ] Choose characters
[ ] Choose a plot
[ ] Choose a solution

Story Starter
The assignment is to write a story.  
Every story has four parts: a setting, 
characters, a plot, and a solution. Press 
ctrl-L to view the steps to complete. 
Write your story in the first person and 
begin with one of the phrases below.

I never noticed...
I remember...
I felt...
I saw...

Viewing the linked file on a 
device...

... and the connected 
AlphaWord Plus file 
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Important: The amount of space available for files is affected by the 
size of data files for other SmartApplets you might be using. For 
example, if you have a SmartApplet such as AlphaQuiz, which needs 
to reserve space for quizzes, the space remaining for AlphaWord Plus 
files will be reduced.

Reaching capacity in a file

When an AlphaWord Plus file is full, a message appears:

If you see this message, as instructed, you should open another file 
in AlphaWord Plus or send the text to your computer.

Checking file size

You can check the size of a file you’re working on to see how many 
pages you’ve written and how much space you have left in that 
particular file. 

To check file size:

1. Press -I. The File Status screen appears.

2. Press any key to exit.
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The File Status screen also shows the pages used in all files and the 
pages available on the system.

To check file size on files in the workspaces:

1. Press shift- -I. The Pages in Files screen appears.

2. Press any key to exit.

Clearing and deleting files
The contents of each file remain on Neo until you explicitly remove 
them. You do so by either clearing files or deleting them:

• Generally, clearing a file removes the contents of unnamed text 
within a workspace or closes a named file. If necessary, you can 
recover the text in the unnamed file, provided you haven’t 
entered new text yet. (See “Recovering data” on page 58.)

• In contrast, when you delete a file, the contents and its name (if 
it exists) are completely removed from the device, and you can’t 
recover any of the data. If the file is associated with a linked file, 
the linked file is deleted as well. 

The action to take—clear or delete—depends on the type of file 
(named or unnamed) and whether it has a linked file associated with 
it. The table shown here summarizes your choices:

The current workspace is marked with an asterisk
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File typ

Unnam
worksp

Named
worksp

Named
worksp

(use ctr

Unnam
linked f

Named
file in a
e Clear File Delete File

ed text in a 
ace

• Clears text (which you can still 
recover)

• Leaves you in the empty, active 
workspace

• Deletes text (no recovery)
• Leaves you in the empty, active 

workspace

 text in a 
ace

• Closes the file and swaps it out 
of the workspace

• Leaves you in the empty, active 
workspace

• Deletes the file and its name
• Leaves you in the empty, active 

workspace

 text not in a 
ace

l-F to view)

• Clears text (which you can still 
recover)

• Keeps file name, resulting in an 
empty named file

• Deletes the file and its name
• Returns you to the workspace you 

were using before (which might or 
might not contain text)

ed text with a 
ile in a workspace

• Clears the unnamed text (which 
you can still recover)

• Keeps linked file text intact and 
clears checkboxes

• Leaves you in the empty, active 
workspace (with linked file 
available)

• Deletes the unnamed text (no 
recovery) and the linked file

• Leaves you in the empty, active 
workspace

 text and linked 
 workspace

• Closes file and gives you a 
choice to:
– Create new text in the 
workspace without a linked file 

– Create new text; keep linked 
file text intact and clear 
checkboxes 

• Leaves you in the active 
workspace

• Deletes the file, its name, and its 
linked file

• Leaves you in the empty, active 
workspace
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Named
file not 

(use ctr

Mixed g

File typ
To clear a file (remove its contents):

1. When the file you want to clear is onscreen, press clear file. A 
prompt appears.

2. Press Y to clear the file; press N to return to the file.

Tip! You can also clear a file from the File Selector by scrolling to 
the file you want to clear and pressing clear file.

Note: You can clear files only when your Neo is not connected to 
your computer. If your device is connected to your computer, 
pressing clear file has no effect.

Clearing all files from the workspaces

You can clear all files in the workspaces simultaneously, which can 
be useful if multiple users have entered information on Neo. You can 
clear files only from the workspaces (they can be either named or 
unnamed files); if you have named files that aren’t in workspaces, 
their contents are not affected.

 text and linked 
in a workspace

l-F to view)

• Clears text in the main file 
(which you can still recover)

• Keeps file name
• Keeps linked file text intact and 

clears checkboxes

• Deletes the file, its name, and its 
linked file

• Returns you to the File Selector 

roup of files Clear All Files from 
Workspaces:
• See other cells in this table for 

descriptions of how the 
command deals with each file 
type

• Leaves you in the empty, active 
workspace

Delete All Files:
• Deletes all text, named files, and 

linked files from the device
• All workspaces are empty
• Leaves you in the empty, active 

workspace

e  (Continued) Clear File (Continued) Delete File (Continued)
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To clear all workspace files at once:

1. Press shift-ctrl-option- -clear file.

2. Press Y to clear all the files; press N to return to the last active 
file.

3. If you have named files with linked files in the workspaces, for 
each file, AlphaWord Plus asks whether you want to keep the 
linked file associated with it. 

Note: If necessary, you can restore these files (one at a time) 
using the data recovery feature as long as you haven’t typed new 
text into the files.

Deleting files

Deleting a file removes all traces of it: its contents, its name (if it’s a 
named file), and its linked file (if one exists). You can delete a single 
file, or you can delete all files on the device, including named files. 
You can’t recover data from a file that’s been deleted.

To delete a file:

1. When the file you want to delete is onscreen, press 
option- -clear file.

2. Press Y to delete the file permanently; press N to return to the 
file.

Tip! You can also delete a file from the File Selector by scrolling 
to the file you want to delete and pressing ctrl-clear file.

To delete a file from a list of files:

1. From within any workspace, press ctrl-D. A list of files appears. 

2. Scroll to select the file you want to delete.

3. Press enter.

4. Press Y to delete the file permanently; press N to cancel. Neo 
returns you to the active workspace.
out AlphaWord Plus 57



58

Maintaining your files
To delete all files:

1. From any workspace, press ctrl-option- -clear file.

2. Press Y to permanently delete all the files (including named files 
not in workspaces); press N to return to the workspace without 
deleting files.

Recovering data
As long as you haven’t deleted a file or entered new text in a file, you 
may be able to recover text you’ve cleared.

To recover a file:

1. Make sure you’re in the workspace of the file you want to recover. 
The screen appears blank.

2. Press option- -R.

The file should reappear onscreen. If it doesn’t, you can try an 
emergency recovery, which may place “garbage” characters in your 
file that you later have to remove.

To perform an emergency recovery of the entire file:

1. Make sure you’re in the workspace of the file you want to recover. 
The screen appears blank.

2. Press shift-ctrl-option- -R. Your file should reappear, possibly 
along with a quantity of garbage characters.

3. Scroll to the location where the garbage characters begin and 
press shift-end to select from the cursor to the end of the file, 
then press delete.
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Chapter 4

Beyond Basics
Beyon
This chapter takes you beyond the simple mechanics of using your 
Neo as a text editor. It explains SmartApplets—what they are and how 
they can extend the usefulness of your Neo. It also explains some 
other tools and commands you might find helpful. Specifically, it 
describes 

• AlphaWord Plus

• Calculator 

• Control Panel customization settings 

• Password protection

• Other useful tools and settings

What is a SmartApplet?
A SmartApplet is a software application you can install on your Neo. 
Neo comes preconfigured with three SmartApplets: AlphaWord Plus, 
Calculator, and Control Panel.

Additional SmartApplets are available from AlphaSmart and other 
developers. Other available SmartApplets let you learn to type, take 
quizzes, create outlines and more. After you purchase one of these 
add-on SmartApplets, you install them on your computer, then use 
AlphaSmart Manager to transfer them onto your Neo.

Note: SmartApplets can’t be installed on older AlphaSmart 
models: the original AlphaSmart, AlphaSmart Pro, or 
AlphaSmart 2000.
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What is a SmartApplet?
The SmartApplets menu
Pressing applets takes you to the SmartApplets menu. This is a good 
way to see which SmartApplets have been installed on your Neo. 

From the SmartApplets menu, you can quickly set a startup 
SmartApplet or disable a SmartApplet. Startup SmartApplets are 
described on page 108, and disabled SmartApplets are described on 
page 110.

To set a startup SmartApplet from the SmartApplets menu:

1. Press applets and scroll to select the SmartApplet you want to 
start when you turn on your Neo.

2. Press ctrl-applets. An asterisk designating the startup 
SmartApplet appears in the menu.

Repeat the steps to turn the setting off. 

To disable a SmartApplet from the SmartApplets menu:

1. Press applets and scroll to select the SmartApplet you want to 
disable.

2. Press ctrl- -L.
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3. Enter the master password (page 116) and press enter. A special 
brackets character designating a disabled SmartApplet appears 
in the menu.

Repeats steps 1 through 3 to enable the SmartApplet.

AlphaWord Plus
AlphaWord Plus is at the heart of Neo. It’s the integrated word 
processor that is already installed on your Neo. Its features are 
described throughout this manual. See the chapter “All About 
AlphaWord Plus” on page 21 for more information.

Calculator
Calculator is a basic six-function calculator that is already installed 
on your Neo. Calculator can perform essential mathematical 
functions including addition, subtraction, multiplication, division, 
exponentiation, and scientific notation.

To use Calculator:

1. Turn on your Neo and press applets.

2. Use the arrow key to select Calculator, then press enter.

Note: The first time you use Calculator, a help screen appears. 
Press esc to exit from it; press -H to view it again.
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3. Type the formula you want to calculate. Consult the table for 
examples on entering formulas. 

Use these operands To perform these tasks

+ Add

Example: 89 + 91 

Example: 15 + 16 + 17

– Subtract

Example: 9 – 2 

Example: 100 – 50 – 25

* or x Multiply 

Example: 2 * 5

Example: 45 x 2 x 8

/ Divide

Example: 18 / 2 

Example: 100 / 2 / 10

^ Exponentiate (raise the first number to the 
power of the second)

Example: 3 ^ 2

Example: 2 ^ 2 ^ 2

e Calculate scientific notation 

Example: 10e6

Example: 1.2e15

( ) Construct more complex formulas

Example: (15 *2) + 10 / 4

Example: (25*3) – (45/5)
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4. Press = or enter to calculate the result.

5. Press esc when you’re through.

Tip! While in Calculator, if you begin the next formula with an 
operand, Calculator uses the result from your previous 
calculation as the first number in the next formula. (This doesn’t 
apply to the e operand.)

The next time you use Calculator, your previous calculations appear. 
Press clear file to remove them.

Calculator’s paper tape
Calculator has a paper tape feature that records a series of 
calculations like a paper-based adding machine. (Calculator can 
record up to fourteen lines of calculations.) As you perform 
calculations, the numbers scroll toward the top of the screen. You 
can copy the series to the clipboard, then paste them into a 
SmartApplet such as AlphaWord Plus.

To use Calculator’s paper tape:

1. Press applets and choose Calculator.

2. Enter a series of calculations.

3. Press shift- -C.

4. Press applets and choose the SmartApplet into which you want to 
paste the series.
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5. Place the cursor in the SmartApplet where you want to paste the 
calculations.

6. Press ctrl-V.

You can also copy just the result in Calculator by pressing ctrl-C and 
pasting it elsewhere, as described in steps 4–6 above. Conversely, 
you can type a formula in AlphaWord Plus, copy it, then paste it into 
Calculator to obtain the result.

Turning off Calculator
There might be times when you want to turn off Calculator. To do 
this, you’ll need to enter a master password. For information on 
master passwords, see “Neo password protection” on page 77. 

To turn off Calculator from AlphaWord Plus:

1. Press ctrl- -C.

2. Type the master password and press enter. 

To turn off Calculator from the SmartApplets menu:

X Press ctrl- -L

Turning Calculator off and on is like a toggle. Follow the same steps 
to turn it on again. You can also turn off Calculator by disabling it in 
AlphaSmart Manager (page 110) or from Control Panel.

Control Panel
Control Panel is a SmartApplet that lets you define settings for your 
Neo. You can also define many of these settings using keyboard 
shortcuts or through AlphaSmart Manager. (For more information 
about AlphaSmart Manager, see “Working with AlphaSmart Manager” 
on page 87).

Note: Control Panel and the keyboard shortcuts are available 
only when your Neo is not connected to a computer.
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You can access Control Panel at any time by pressing applets. The 
settings you can define in Control Panel are shown in the following 
table. Settings that aren’t described elsewhere in this manual are 
described in their own sections following this table. 

Control Panel settings Description

Spell Check settings

(page 67)

Turn Spell Check on and off

Turn add words to user 
dictionary on and off

Delete user dictionary

Add a new word to the user 
dictionary

AlphaWord settings

(page 68)

(page 78)

(page 79)

(page 80)

Turn Show Marks on and off

Turn file passwords on and off

Change a specific file password

Reset all file passwords

Change default SmartApplet font

(page 28)

Sets the font size for 
SmartApplets on the device

Turn Calculator on/off

(page 64)

Turns Calculator on and off

Two-button On

(page 68)

Sets whether two buttons are 
required to turn on device

Set Screen Contrast

(page 69)

Sets your screen lighter or 
darker

Keyboard command reference list 
(page 137)

Lists keyboard commands for a 
variety of actions 

View keyboard layout

(page 69)

Displays a representation of the 
current keyboard layout
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To set options using Control Panel:

1. Press applets, scroll the list to select Control Panel, then press 
enter.

2. Scroll to select the option you want to set and press enter.

3. If requested, enter the master password (page 77). (Some 
settings, such as turning Calculator or Spell Check on and off, 
require that you enter the master password first.)

4. Step through the onscreen instructions until you’re satisfied with 
the setting.

5. Press esc to return to the previous screen. You might need to 
press esc several times to return to Control Panel or the 
SmartApplets menu.

Display battery status

(page 134)

Shows how much battery power 
is left on the device

Change keyboard settings

(page 72)

(page 75)

(page 76)

Changes keyboard layout 
(QWERTY, Dvorak, Right, or 
Left)

Changes Slow Keys setting

Turns Sticky Keys on and off

Control Panel settings (Continued) Description (Continued)
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Spell Check settings
To change Spell Check settings in Control Panel, you need to enter 
the master password. The Spell Check settings you can manage from 
Control Panel are

• Turn Spell Check off and on. This setting is a toggle; you select 
it and press enter to turn it off and repeat those steps to turn it 
back on. 

• Turn add words to user dictionary off and on. This setting is a 
toggle; you select it and press enter to turn it off and repeat those 
steps to turn it back on. 

• Delete user dictionary. This setting deletes the user dictionary. 
Use caution when selecting this setting; you can’t recover a user 
dictionary that’s been deleted. (You can, however, send a new 
user dictionary to devices by using AlphaSmart Manager. See 
“Sending a user dictionary to Neo” on page 118 for details.)

• Add new word to user dictionary. This setting lets you add 
words to the user dictionary, one word at a time. If you have a big 
list of words you want to add, it’s more efficient to create a text 
file of words and send it to your Neo using AlphaSmart Manager.

AlphaWord settings
You can control certain AlphaWord settings through Control Panel: 
Show Marks and file passwords. Show Marks is described in the 
following section; file passwords are described on page 78. 
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Show Marks

Show Marks is a setting that shows right arrows when you use tabs 
and return arrows when you use carriage returns.

The right arrows and return arrows don’t transfer to your computer, 
but the tabs and returns do.

The Show Marks setting in Control Panel is a toggle; you select it and 
press enter to turn it on and repeat those steps to turn it back off. 
You can also set Show Marks from within AlphaWord Plus.

To enable or disable Show Marks within AlphaWord Plus:

1. Press option- -K.

2. Press 3, then press esc to exit the screen and return to your file.

Two-button On setting
The Two-button On setting lets you control whether you turn your 
Neo on with one key press or two. Neo’s default behavior is to turn 
on when you press on/off. But if you frequently transport your Neo in 
a backpack or briefcase, you might want to change this behavior so 
that you don’t inadvertently turn the device on in transport and drain 
power from it.

When you enable this option, you must press and hold down enter, 
then press on/off to turn your Neo on.

Carriage return

Tab
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Set Screen Contrast setting
The Set Screen Contrast setting lets you control how light and dark 
both the screen background and onscreen characters appear. This 
lets you optimize the screen for the lighting conditions in your 
environment.

When you select this setting, you use the arrow keys to change the 
contrast. A higher number darkens the background; a lower number 
lightens both the background and text. The setting ranges 
from 1 to 16.

View Keyboard Layout settings
An option in Control Panel lets you view different keyboard layouts 
onscreen. This can be useful if you’ve switched to a different layout 
from what you’re used to and you’re not quite sure of the new 
locations of keys.

You can also use this option to view a second screen on how to enter 
these commonly used special characters:

Note: ISO (European) keyboard layouts vary slightly from the 
following illustrations, which depict ANSI (US) keyboards.

£ ¥ ® « ¶ µ ¢ ¡ ™ ˜ ˆ ƒ ß  

  ÷ . ¨`§ ´  © ø æ å ç

Ω

π Σ ∞
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To view a keyboard layout onscreen:

1. Press applets, scroll the list to select Control Panel, then press 
enter. 

2. Scroll to select View keyboard layout and press enter. The layout 
appears onscreen.

3. Press shift to view the layout when you type with the shift key.

To view commonly used special characters for a keyboard layout:

1. Press applets, scroll the list to select Control Panel, then press 
enter. 

2. Scroll to select View keyboard layout and press enter. The layout 
appears onscreen.

3. Press and hold option. A new screen appears showing special 
characters.

4. Note the location, relative to the keyboard, of the character you 
want to type.

5. While keeping option held down, press shift to view additional 
special characters available when you type with both the option 
and shift keys, and again, note their location.
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6. Press esc to return to the previous screen. You might need to do 
this several times to return to the Control Panel or SmartApplets 
menu.

7. Switch to the SmartApplet (such as AlphaWord Plus) and file 
where you want to enter the special character.

8. Press and hold option (or option-shift) while pressing the key you 
noted in step 4 or 5.

Tip! You can view a list of international characters starting on 
page 142 or by pressing ctrl-H in AlphaWord Plus.

Battery status setting
You can quickly check the battery status of your Neo from Control 
Panel. When you select Display Battery Status, Control Panel displays 
a percentage of power remaining on the device.

Change keyboard settings
The following table summarizes the various keyboard settings you 
can configure to customize your Neo. Each option is explained in its 
own section following the table. You can configure these settings 
through Control Panel (except for Auto Repeat), through AlphaSmart 
Manager, or with keyboard commands.

Option Does this

Keyboard layouts Sets alternate keyboard layouts

Slow Keys Sets a time delay for holding down a key before 
the character appears onscreen

Sticky Keys Sets whether you must hold keys down for 
keyboard commands or whether you can press 
them sequentially

Auto Repeat Sets whether keys repeat when held down
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Keyboard layouts

Neo gives you a choice of four different keyboard layouts to provide 
for special needs or preferences:

• QWERTY, the standard default layout of most keyboards and 
typewriters

• Dvorak, a scientifically-designed keyboard layout that requires 
much less finger reaching and stretching for the most commonly 
used keys, and results in faster and easier typing

• Right hand only, a layout that lets people with special needs type 
faster 

• Left hand only, a layout that lets people with special needs type 
faster

Note: The illustrations shown in the following task depict layouts 
on ANSI (US) keyboards. ISO (European) keyboard layouts vary 
slightly. Use the View Keyboard Layout option in Control Panel 
(page 69) if you have an ISO keyboard and want to check key 
locations for the different specialized layouts.

To change the keyboard layout:

1. Do one of the following:

• From Control Panel, select Change Keyboard Settings, then 
select Change Keyboard layout.

• From within a SmartApplet, press option- -L. 
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2. Select a keyboard layout from the following choices:

• Press 1 to select the QWERTY layout. 

• Press 2 to select the Dvorak layout. 
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• Press 3 to select the right hand only layout. 

• Press 4 to select the left hand only layout. 

When you turn on your Neo, it displays a message about the current 
layout setting if you’ve chosen a keyboard layout other than the 
default QWERTY layout.

Note: When you switch keyboard layouts, all dialog boxes and 
keyboard commands conform to the new layout. The command 
keys (ctrl, option, , for example) remain in the same location, 
but letter keys are derived from the new layout. For instance, to 
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access the Speed menu, you still press option- -S, but the S key 
is in a different location. 

Important: When you send text to your computer from your Neo using 
a USB cable and send, the computer must use a QWERTY layout. 

Slow Keys

Slow Keys is a setting that lets a user set a delay time between 
pressing a key and having that character appear onscreen. This 
setting is useful for someone with unsteady hands or difficulty in 
targeting specific keys. 

For example, if you set the Slow Keys option to one second, you 
would have to press and hold down a character key for one entire 
second before that character would appear. One second is probably 
too long a delay for many users, but some fraction of a second might 
help alleviate inadvertent typing for certain users. 

To set a Slow Keys delay:

1. Do one of the following:

• From Control Panel, select Change Keyboard settings, then 
select Change Slow Keys setting.

• From within a SmartApplet, press ctrl-option- -K.

2. Press the K or L repeatedly until you reach the time delay you 
want.

3. Press enter to accept the change or press esc to exit the screen.

If the Slow Keys delay is greater than one second, the Auto Repeat 
delay (normally about one second) increases to match it. For 
example, if the Slow Keys delay is set to 1.5 seconds, the Auto Repeat 
delay (page 76) resets to 1.5 seconds as well. This means that after 
pressing and holding a key down, 1.5 seconds pass before the 
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character appears, and after an additional 1.5 seconds, the character 
begins to repeat.

Sticky Keys

On most computers, you have to hold down and press several keys 
simultaneously to activate some commands. (Some examples are 
pressing shift and a letter key to produce a capital letter, or ctrl-A to 
select all text.) This is true of Neo too. Neo has a sticky keys setting 
that lets you turn this behavior off while typing. This is useful for 
people just learning to type or who have difficulty holding down 
several keys at once. 

For example, when you turn on Sticky Keys, you can type 
combinations of keystrokes one at a time without holding each key 
down. So you could, for instance, press option, then , then S 
individually to get to the Send Speed menu, rather than pressing all 
three keys as a group.

Sticky Keys affects these four keys: shift, option, , and ctrl. When 
Sticky Keys is on, pressing one of these keys effectively keeps that key 
pressed down for the next normal key press. 

The Sticky Keys setting in Control Panel is a toggle; you select it and 
press enter to turn it on and repeat those steps to turn it back off. 
You can also set Sticky Keys from within AlphaWord Plus.

To turn Sticky Keys on or off from within a SmartApplet:

1. Press option- -K.

2. Press 2, then press esc to exit the screen and return to your work.

Auto Repeat

Auto Repeat lets you set whether keys repeat when held down. 
Usually if you press and hold a character key for an extended period 
of time, the letter continually repeats itself across the screen.
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You can change this behavior so that keys won’t repeat. This is 
helpful for beginning typists or for users who have difficulty typing. 
For example, if you’re administering an activity to a group of users 
whose typing skills are at a beginning level, you can turn off Auto 
Repeat so they aren’t penalized for holding down a key longer than 
normal. 

When Auto Repeat is on (the default setting), a character repeats 
when a key is held down; when it’s off, only one character appears per 
keystroke. 

Neo password protection
There are three types of passwords you can set for Neo.

• Send list password: This password is specific to AlphaSmart 
Manager. It lets you set a password so that no one can send 
anything—files, SmartApplets, settings—from AlphaSmart 
Manager to any connected Neo(s) without first typing the send 
list password. See “Send list password” on page 115.

• Master password: This password controls various settings such as 
turning Calculator or Spell check on or off (as well as some other 
settings). Additionally, on Neo, it permits you to create individual 
file passwords. You can obtain a master password from 
AlphaSmart Technical Support, but it’s easier—and more 
secure—to specify your own using AlphaSmart Manager (see 
page 116 for more information about using AlphaSmart Manager 
to control password protection).

• File passwords: You can set individual passwords for each 
AlphaWord Plus file. You can set these passwords on Neo, or set 
a global password for all the files in AlphaSmart Manager. 
Individual passwords are useful when multiple users share one 
Neo, or when the contents of your files are confidential.
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Note: Neo’s password system is meant to protect against 
accidental or mischievous data loss, and to provide a minimum 
level of data privacy. It cannot prevent concerted, malicious 
efforts at data destruction. 

Enabling password protection
When you first receive your Neo, you cannot set individual file 
passwords without first enabling (permitting) password protection, 
for which you need a master password. It’s recommended that you 
set your own master password in AlphaSmart Manager (see “Master 
password” on page 116) for greater security.

Enabling password protection is more easily accomplished in 
AlphaSmart Manager, but if you know your master password, you can 
also enable it on the device with a keyboard command or with 
Control Panel. 

To enable password protection:

1. Be sure you know your master password (see page 116).

2. Turn on Neo and make sure it is not connected to a computer.

3. Do one of the following:

• From Control Panel, select AlphaWord settings, then select 
Turn File Passwords On/Off.

• From AlphaWord Plus, press ctrl-option- -p. 

The following message appears.

4. Type the master password and press enter.

Repeat these steps to disable password protection.
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Setting an individual password

Each AlphaWord Plus file can have its own unique password, but the 
first time you enable password protection, the individual file 
passwords are all set by default to the word write. You will need to 
enter (or have your group of users enter) this word as the current 
password before you can change it to something more meaningful. 

Passwords can be up to six characters long. They aren’t case-sensitive 
and can contain alphanumeric characters and symbols but not 
spaces.

Note: A global file password can also be set in AlphaSmart 
Manager.

You can change a file password from Control Panel or from within 
AlphaWord Plus.

Note: Individual file passwords can be overridden by typing the 
master password.

To change a file password from Control Panel:

1. From Control Panel, select AlphaWord settings, then select 
Change a specific file password.

2. Scroll to select the file whose password you want to change.

3. Type the current password, the new password, then the new 
password again (you can press the tab key to go from one field to 
the next) and press enter when you’re done. A message appears 
telling you the password was changed.

4. Press any key to return to AlphaWord settings.
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To change a file password from within AlphaWord Plus:

1. Open the file where you want to change a file password.

2. Press option- -P to show the Change Password screen. 

3. Type the current file password, your new password, and your new 
password again to confirm it.

4. Press enter. You’ll see a message that the password has been 
changed, then you’re returned to your file. 

When password protection is enabled, any time you switch between 
files, you’re prompted for that file’s password before being allowed to 
edit that file. 

Password reset

There may be times when you (or a group of users) can’t remember 
individual file passwords. You can reset all the file passwords 
globally to the factory default word write. You can reset passwords 
from Control Panel or from within AlphaWord Plus.

To reset all file passwords from Control Panel:

1. From Control Panel, select AlphaWord Plus settings, then select 
Reset all file passwords.

2. Type the master password and press enter.

To reset all file passwords from within AlphaWord Plus:

X Press shift-ctrl-option- -P and enter the master password.

You can also reset all file passwords using AlphaSmart Manager.
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System status
For a quick view of the current settings on your Neo, you can check 
system status. The settings that appear are

• System version

• Language

• Current file you’re in

• Cable speed (for text transfers to your computer)

• Keyboard layout

• Auto Repeat setting

• Sticky Keys setting

• Passwords setting

To check system status:

1. Press option- -V.

Note: The system status screen for a Neo with an ISO (European) 
keyboard differs slightly from the one shown here. 

2. Press any key to exit the screen and return to your file. 

Typing Timer
The Typing Timer is a tool you can use to evaluate typing proficiency. 
It lets you perform any keyboarding exercise and, when stopped, 
displays the elapsed time and words per minute (WPM) typed. 
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You can’t delete characters while using the Typing Timer. This is so 
you can evaluate keyboard mistakes. Pressing backspace while using 
the Typing Timer has no effect. (Note that the final WPM result 
doesn’t subtract for errors made while typing.) You can edit the text 
you type after turning off the Typing Timer. 

To start the Typing Timer:

1. Do one of the following:

• In an existing file, place the cursor where you want to start 
the Typing Timer.

• Switch to an empty file by pressing one of the file keys.

• Clear the current file by pressing clear file.

2. Press -find. The following message appears.

3. Start typing. The elapsed time appears as you type. 

4. Press caps lock to stop. The elapsed time and words per minute 
appear.

5. To start the timer again, press enter.

6. To exit the timer, press esc.
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Tips for working with your 
applications
Much of this guide describes sending your text to a word processing 
application on your computer, but you can send text to any 
application that accepts text:

• Multimedia text fields

• Text tools in a page layout or graphics application

• Email applications

• Spreadsheets

Wherever you would normally type text in your application, you can 
easily send text from Neo by placing your cursor at the appropriate 
location in your application and pressing send.

Sending text to a spreadsheet
Spreadsheets keep track of information in columns and rows. On 
Neo, you might set up some of your data in AlphaWord Plus using 
tabs and returns to eventually transfer into a spreadsheet application 
on your computer.

You can transfer text directly into a spreadsheet without formatting 
problems if you beam it. However, for some spreadsheet 
applications, transferring the text (if it contains tabs and carriage 
returns) using a USB cable doesn’t produce the desired results. If 
your text doesn’t appear in columns as you’d expect, try sending the 
text to a word processing application first. Then select the text in the 
word processing application, copy it, and paste it into your 
spreadsheet file. The paste operation usually produces more 
desirable results.

Tip! In general, if you’re having formatting problems with text 
you’ve sent from your Neo, try sending it first to a word 
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processing application, then pasting into the application where 
you experienced the formatting problems.

Changing the transfer speed
Neo can send text faster than some older computers can accept it. If 
you notice missing characters or jumbled text, then you need to slow 
down the transfer speed. Even on newer, faster computers, some 
applications are slow to accept text and you must slow down your 
Neo to transfer text into these applications. You can change the 
transfer speed for both USB cable and IR transfers.

To change the transfer speed for a USB cable connection:

1. Make sure your Neo is not attached to your computer. (You can 
change the transfer speed only when the Neo is not attached.)

2. Press option- -S and type the number that corresponds to one of 
the following options:

• Very Slow (1). This is the slowest speed setting and is 
compatible with all machines and applications. It is 
recommended especially when you use graphics intensive 
applications. 

• Slow (2). This setting is compatible with all machines and 
most applications. 

• Fast (3). This the default speed and usually works well with 
most Macintoshes and PCs. 

• Fastest (4). This setting provides the quickest transfers. 
However, some word processing applications may experience 
a loss of data when files are transferred using this mode, so 
you might want to experiment to see which speed works best 
for you.
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To change the transfer speed for beaming:

X Press ctrl-option- -S and type the number that corresponds to 
one of the following options:

• Fastest speed (1). This setting provides the quickest IR 
transfers. However, some applications may experience a loss 
of data when files are transferred using this mode, so you 
might want to experiment to see which speed works best for 
you. 

• Compatibility speed (2). This setting is compatible with all 
machines and most applications. 
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Working with AlphaSmart
Manager
Worki
This chapter describes AlphaSmart Manager, the software component 
of your Neo package. Specifically, it explains

• Basic AlphaSmart Manager ideas

• Starting AlphaSmart Manager and checking connection status 

• Viewing, printing, and saving files from your Neo

• Sending AlphaWord Plus files from your computer to your Neo

• Installing and removing SmartApplets

• Configuring settings globally 

• Creating send lists to use over and over again

AlphaSmart Manager displays its full capabilities when used to 
manage and maintain a group of Neos connected to an AlphaHub. 
This chapter focuses on fundamental concepts about AlphaSmart 
Manager. For complete information about AlphaSmart Manager, 
including information about using it in a group setting, consult the 
AlphaSmart Manager 2 User’s Guide. 

AlphaSmart Manager basics
AlphaSmart Manager is an application you use on your computer to 
help you manage files, settings, and SmartApplets on your Neo. It 
streamlines many of the tasks you perform manually on your Neo and 
lets you easily transfer files back and forth between your computer 
and your Neo. 
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You can always send a file from your Neo to your computer with a 
single click of the send key, but AlphaSmart Manager lets you transfer 
up to eight files at the same time, which is a great timesaver for 
saving and printing. You can transfer files the other way too: from 
your computer to your Neo. 

Note: AlphaSmart Manager works with files in Neo’s eight 
workspaces. To send a file from your Neo to AlphaSmart 
Manager, the file must occupy a workspace. By the same token, 
to transfer a file from AlphaSmart Manager to your Neo, you 
must transfer it to a workspace.

AlphaSmart Manager also acts as a central control spot, letting you 
choose and set passwords, configure settings as a group, and create 
send lists that you can save and reuse. 

Sending and saving
An important concept to learn is that any task you do or change you 
make in AlphaSmart Manager appears in the send list. The send list 
collects the changes—whether they’re to file contents, settings, or 
SmartApplets—and holds them until you send them to your Neo. 
This lets you review the changes before actually sending them to 
connected Neos

A send list
in AlphaSmart 
Manager
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Note: In previous versions of AlphaSmart Manager, send lists 
were called configuration files.

If you find yourself performing the same activities over and over again 
in AlphaSmart Manager, you can save these activities in a send list 
and use it whenever you need to. 

For more information about sending and saving, especially to a 
group of Neos connected to an AlphaHub, see the 
AlphaSmart Manager 2 User’s Guide. 

Starting AlphaSmart Manager
Most likely you installed AlphaSmart Manager on your computer 
when you received your Neo. If not, install it now by following the 
instructions in “Installing AlphaSmart Manager” on page 14. 
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To start AlphaSmart Manager:

1. Double-click the AlphaSmart Manager icon on the desktop. 
AlphaSmart Manager appears onscreen.

2. Turn on your Neo, press applets, and connect it to your computer, 
as described on page 9.

3. In AlphaSmart Manager, click the plus sign (PC) or triangle 
(Macintosh) at the bottom of the screen to view connection 
status.You might need to wait a few moments before the 
connection status light appears. 

Color indicates 
connection status

Click to expand or 
contract the 
Connection Status 
area.
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• Green light: your Neo is properly connected

• Yellow light: your Neo is connected, but the system files 
need to be updated 

• Black light: your Neo is not connected or improperly 
connected (refer to “Troubleshooting” on page 123)

When you’re properly connected, you can transfer information 
between your Neo and your computer.

The remainder of instructions in this chapter assume that you’ve 
properly connected your Neo to your computer and are running 
AlphaSmart Manager.

Viewing, printing, and saving files 
from your Neo
An earlier chapter in this manual describes how to send files from 
your Neo to an open application on your computer (“Sending text to 
a computer” on page 10). You can use AlphaSmart Manager to do the 
same thing: retrieve files from the workspaces on your Neo. 
Additionally, with AlphaSmart Manager, you can use your computer 
to view the workspace files on the device, print them, or save them as 
separate text files.

If you retrieve a workspace file that has a linked file associated with it, 
you retrieve the linked file text as well. In this case, when you view, 
print, or save the file, the linked file text is appended to the end of 
the main file. Linked files are discussed in “Using linked files” on 
page 45.

AlphaSmart Manager retrieves files from workspaces only. AlphaWord 
Plus can name and store files that don’t occupy a workspace. 
Consequently, you need to make sure you swap the files you want to 
view, print, or save into the workspaces.
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Viewing files
You can view the contents of an AlphaWord workspace file from 
within AlphaSmart Manager. You can view only one workspace file at 
a time.

To view an AlphaWord file:

1. In AlphaSmart Manager, click the Get/Print AlphaWord Files tab 
and view the device (called AlphaSmart USB) in the File Contents 
list.

2. In the File Contents area, click the plus sign (PC) or triangle 
(Macintosh) of the device. A message appears briefly, saying that 
AlphaSmart Manager is retrieving the file(s).
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3. Click the displayed file text to select the file contents you want to 
view.

4. Click View File. The file appears in its own window.

5. You can save the file from here, or click Close to close the window 
and return to AlphaSmart Manager.

Click to 
select the 
file you 
want to 
view
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Printing files from AlphaSmart Manager
You can use AlphaSmart Manager to print workspace files that are on 
your Neo. Steps for printing vary slightly between PC and Macintosh 
computers.

To print files from AlphaSmart Manager on a PC:

1. In AlphaSmart Manager, click the Get/Print AlphaWord Files tab.

Tip! If you know exactly which files you want to print, check those 
files in the File Contents list. 

2. Click Print Files. A print dialog box appears. 

The files to 
print

Print options
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3. Indicate the files you want to print:

• All Files. Prints all workspace files on your Neo.

• Checked Items. Prints only the files you checked.

• File #. Prints only that numbered file.

4. Select the print options you want:

• Print header information on first page. Prints header 
information (AlphaSmart USB and the file number) on the 
first page only. 

• Print header information on all pages. Prints header 
information (AlphaSmart USB, the file number, and the page 
number) on all pages.

• Do not print header information. Omits header information 
from all pages.

• Print empty file as blank page. Prints empty files as blank 
pages, which provides a useful visual clue if you’re printing 
many files from many devices.

5. Click Print. 

To print files from AlphaSmart Manager on a Macintosh:

1. In AlphaSmart Manager, click the Get/Print AlphaWord Files tab.

Tip! If you know exactly which files you want to print, check those 
files in the File Contents list. 
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2. Click Print Files. A print dialog box appears. 

3. Click the Copies & Pages list and select AlphaSmart Manager. 
The dialog box displays print options specifically for AlphaSmart 
Manager.

The files to print

Print options

Select AlphaSmart Manager from the list 
to display appropriate print options
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4. Indicate the files you want to print:

• All Files. Prints all workspace files on your Neo.

• Checked Items. Prints only the files you checked.

• File #. Prints only that numbered file.

5. Select the print options you want:

• Print header information on first page. Prints header 
information (AlphaSmart USB and the file number) on the 
first page only. 

• Print header information on all pages. Prints header 
information (AlphaSmart USB, the file number, and the page 
number) on all pages.

• Do not print header information. Omits header information 
from all pages.

• Print empty file as blank page. Prints empty files as blank 
pages, which provides a useful visual clue if you’re printing 
many files from many devices.

6. Click Print. 

Printing linked files

When you print an AlphaWord Plus file that has a linked file 
associated with it, the linked file prints on a separate page. Linked 
files are discussed in “Using linked files” on page 45.
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Saving files
You can use AlphaSmart Manager to save workspace files that are on 
your Neo. Files are saved in their own folders as text files.

AlphaWord Plus files 
saved on a PC

AlphaWord Plus files 
saved on a 
Macintosh
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To save AlphaWord Plus files:

1. In AlphaSmart Manager, click the Get/Print AlphaWord Files tab 
and review the files in the File Contents list.

Tip! If you know which files you want to save, check those files in 
the File Contents list. 

2. Click Save Files. A Save File dialog box appears.

3. Browse to the location where you want to save the file, then 
select save options:

• All Files. Saves all workspace files from your Neo.

• Checked Items. Saves only the files you checked.

• File #. Saves only that numbered file.

4. Click Save. The file(s) are saved as text files in the location you 
specified, in the AlphaSmart USB folder.

Sending files to your Neo
AlphaSmart Manager can send files you’ve created on your computer 
to your Neo. You can compose text in another application and paste 
or drag it into AlphaSmart Manager, or type text directly into 
AlphaSmart Manager. 
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Warning! Before you send anything to your Neo, it’s important to 
know that once you begin sending files (or SmartApplets or settings) 
to your Neo, you need to let AlphaSmart Manager complete the send 
before disconnecting your Neo from your computer. If you don’t, you 
run the risk of corrupting system files on your Neo.

To send a file to your Neo:

1. In AlphaSmart Manager, click the AlphaWord Files to Send tab.

2. Select the number of the file to which you want to send text. 
AlphaSmart Manager checks the checkbox of the file you 
selected.

3. In the File # area, type the text you want to transfer, or paste or 
drag the text from another application.

Tip! To clear text you’ve added to the file you’re working with, 
choose Edit > Select All, then press Delete or Backspace. To clear 
text you’ve added to two or more files, click Clear All Text. 
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4. Click the Send List tab and verify that the text you want to send 
appears in the Send List Display.

5. Click Send.

You can transfer multiple files simultaneously. To do so, repeat steps 
2 and 3 until you’re ready to send, then review the Send List Display 
to make sure all the files appear before clicking Send.

Sending empty files
In the AlphaWord Files to Send tab, you can check the file number of 
an empty workspace and send it to your Neo. If you do so, you 
overwrite any existing text in that workspace. This is a handy trick to 
use if you’ve retrieved text from your Neo and no longer need the text 
in the Neo workspaces. Simply check and send empty files to delete 
text in the workspaces.

If you want to delete all the AlphaWord Plus files from your Neo, 
including named files that aren’t in workspaces, it’s better to use the 
Delete All Files setting, described in “AlphaWord Plus settings” on 
page 110.
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Installing SmartApplets
SmartApplets are software applications you purchase and install to 
extend the functionality of your Neo. You install a SmartApplet on 
your computer, then select it and send it to your Neo with 
AlphaSmart Manager.

For more information about available SmartApplets, visit the 
AlphaSmart web site.

To install a SmartApplet on your Neo:

1. Install the SmartApplet on your computer, following the 
directions in the SmartApplet package.

2. In AlphaSmart Manager, click the SmartApplets tab. 

3. In the SmartApplet List, click the SmartApplet you want to 
install, then click Add. You can ctrl-click, -click, or shift-click to 
select multiple SmartApplets.

4. Keep an eye on the Memory column to be sure there is enough 
memory available on the device to install the SmartApplets you 
want.

Click to select 
the SmartApplet 
to add, then click 
Add
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The Memory column shows both the amount of memory in use by 
SmartApplets on your Neo and the amount of memory needed 
for the SmartApplets you want to install.

Tip! If you don’t have enough memory to install the 
SmartApplets you want, consider deleting the existing 
SmartApplets on your Neo to free up memory. See “Deleting 
SmartApplets” on page 104 for more information.

5. Click the Send List tab and verify that the SmartApplets you want 
to install appear in the Send List Display.

6. Click Send.

Memory needed to 
install the SmartApplets 
you selected

Memory already in use on 
your Neo
ng with AlphaSmart Manager 103



104

Installing SmartApplets
Tip! If you don’t see the SmartApplet you want to install in the 
list, and you know you installed it on your computer, choose 
File > Add to Applet List and browse to the SmartApplet’s 
location on your computer. 

Deleting SmartApplets
You remove SmartApplets on your Neo by using the SmartApplets 
tab in AlphaSmart Manager. You might want to remove SmartApplets 
to free up memory or because you’re beginning a new session or 
activity. 

When you remove SmartApplets, you’re actually having AlphaSmart 
Manager install the set of SmartApplets you want and delete any 
extraneous SmartApplets that are on your Neo but not in your install 
list. 

Important: If you remove extraneous SmartApplets, you also remove 
any files associated with the SmartApplets you’re deleting. (For 
example, if you remove KeyWords, you also remove any KeyWords 
lessons and progress reports.) If there are files on the devices that 
you want to save, be sure to retrieve them first.

Tip! If there’s a SmartApplet on your Neo, and you want to 
prohibit access to it, consider disabling it rather than removing 
it. Disabling turns off the SmartApplet until you enable it again. 
This saves you from having to reinstall the SmartApplet later. 
Some SmartApplets take a significant amount of time to install; 
disabling rather than deleting might be useful if you plan to use 
the SmartApplet in the future but want to prevent access for 
specific activities. See page 110 for more information about 
disabling SmartApplets.
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To delete SmartApplets:

1. In AlphaSmart Manager, click the SmartApplets tab. 

2. Click the SmartApplets you want to install in the SmartApplets 
List, then click Add. 

3. Check the option Delete SmartApplets that are not in the 
SmartApplets Install List from AlphaSmart Devices.

4. Click the Send List tab and verify that only the SmartApplets you 
want appear in the Send List Display.

5. Click Send.

“Hidden” SmartApplets

You might notice that some SmartApplets appear in the lists in an 
italicized font. These aren’t standalone SmartApplets. This means 
that they don’t appear in the SmartApplets menu on the devices 
(thus, they are “hidden”), but they do appear in AlphaSmart Manager 
and take up memory. 

For example, Spell Check is not a standalone SmartApplet. You can’t 
access it directly on your Neo. But if Spell Check is installed on a 
device, SmartApplets such as AlphaWord Plus use it to check 
spelling. 

Defining settings
You can define system settings and individual SmartApplet settings 
through AlphaSmart Manager. Some of these settings are described 
in more detail in “Beyond Basics” on page 59.

System settings are options that apply to all functions of your Neo. 
No matter which SmartApplet you’re using, these settings are 
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in effect. SmartApplet settings, on the other hand, apply only to 
particular SmartApplets.

The system settings you can configure in AlphaSmart Manager are 
summarized in the following table. 

This setting Does this
Additional 
information

Startup 
SmartApplet

Lets you designate which 
SmartApplet appears first 
when you turn on your Neo

See page 108

Auto Repeat Sets whether keys repeat when 
held down

See page 76

Sticky Keys Sets whether you must hold 
keys down for keyboard 
commands or whether you can 
press them sequentially

See page 76

Keyboard 
Layout

Lets you select alternate 
keyboard layouts

See page 72

Idle Time Sets the time that a Neo can 
be idle before turning off (4–59 
minutes)

Choose a number 
between 4 and 59 
minutes

Slow Keys and 
Slow Key 
Delay

Sets a time delay for holding 
down a key before the 
character appears onscreen

See page 75

Reset System 
Font to 
Default

Sets your Neo to the four-line 
fixed-width system font

See page 30

Transfer Speed Sets the rate of transfer when 
connected to a computer by 
cable

See page 84

IR Transfer 
Speed

Sets the rate of transfer when 
beaming to a computer

See page 84
Neo User’s Guide



Worki

Defining settings
To modify system settings through AlphaSmart Manager:

1. In AlphaSmart Manager, click the Settings tab.

2. Select System in the Settings List.

3. In the System Settings area, check the settings you want to 
change, specifying additional information as appropriate. (You 
might need to scroll down to view all the settings.)

Master 
Password

Lets you set your own personal 
master password for your Neo 

See page 116

Printer 
Selection

Doesn’t apply to Neo but is 
provided in AlphaSmart 
Manager for compatibility with 
other AlphaSmart devices

Two-button 
ON

Lets you specify that two keys 
must be pressed at the same 
time—enter and on/off—to 
turn your Neo on

See page 68

This setting 
(Continued) Does this (Continued)

Additional information 
(Continued)
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Note: When you change settings, notice that AlphaSmart 
Manager automatically checks the System checkbox on the left. If 
you uncheck this checkbox, changes you make to settings won’t 
be sent to your Neo. 

4. Click the Send List tab and verify that the settings you want to 
send appear in the Send List Display.

5. Click Send.

Startup SmartApplet

If you designate a startup application in the Settings list, it becomes 
the SmartApplet that appears first when you turn on your Neo. If you 
don’t select a startup SmartApplet, Neo places you in whatever 
SmartApplet and file you were working in when you turned the device 
off. You can choose only one SmartApplet as the startup application. 

Defining settings for SmartApplets
SmartApplets have settings specific to them, which you can set in 
AlphaSmart Manager. AlphaWord Plus, for example, has several 
settings; other SmartApplets have only one. 

In order for you to select a setting associated with a SmartApplet, the 
SmartApplet must appear in the Settings list. The SmartApplets that 
Neo User’s Guide



Worki

Defining settings
appear in the list are those you chose to install on the SmartApplets 
tab, plus the SmartApplets that are present on all connected devices 
(not just some). 

If a you want to select a setting for a SmartApplet, and that 
SmartApplet doesn’t appear in the list, it means one of three things: 

• You haven’t selected it as a SmartApplet to add on the 
SmartApplets tab.

• It hasn’t been installed on your Neo yet.

• It’s been installed on some connected devices, but not all of them 
(when working with AlphaSmart Manager and an AlphaHub).

To define SmartApplet settings through AlphaSmart Manager:

1. In AlphaSmart Manager, click the Settings tab.

2. Select the SmartApplet in the Settings List.

3. Check the settings you want to change, specifying additional 
information as appropriate. 

The SmartApplets that appear in the Settings List are those you chose to 
install on the SmartApplets tab, plus the SmartApplets already present on 
all connected devices
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Note: When you change settings, notice that AlphaSmart 
Manager automatically checks the corresponding SmartApplet 
checkbox on the left. If you uncheck this checkbox, changes you 
make to those settings won’t be sent to your Neo. 

4. Click the Send List tab and verify that the settings you want to 
transfer appear in the Send List Display.

5. Click Send.

The Disable This SmartApplet setting

The setting that every SmartApplet has is the Disable setting, which 
lets you turn off access to that SmartApplet. For example, you might 
disable Calculator if you want to prevent access to electronic 
calculations. You can disable multiple SmartApplets.

AlphaWord Plus settings

AlphaWord has its own settings that you can control through 
AlphaSmart Manager. These settings are listed in the following table. 

This setting Does this
Additional 
information

Disable This 
SmartApplet 

If off, prevents the user from 
accessing AlphaWord Plus

See page 110

Passwords 
enabled 

Enables the use of individual 
file passwords in AlphaWord 
Plus

See page 78
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File sizes

In AlphaWord Plus, you can set minimum and maximum file sizes. A 
maximum file size lets you have more text in your files. A minimum 
file size ensures that some amount of space is kept in reserve for 
workspace files.

You can change the file size to allow for longer file lengths, which is 
helpful if your documents tend to run longer. Be aware, however, that 
the total amount of space available on a device remains the same. 
(Keep in mind too that additional SmartApplets and data files—such 
as AlphaQuiz, quizzes, and student responses—also take up space on 
a device and can affect the amount of space left for AlphaWord Plus 
files.)

Set File 
Passwords

Specifies a common password 
for all AlphaWord Plus files

See page 117

Show Marks Sets whether to display arrows 
where there are tabs and 
carriage returns

See page 68

Maximum File 
Size 
(in characters)

Set by default to 51,200 
characters (approximately 25 
pages)

See page 111

Minimum File 
Size 
(in characters)

Set by default to 512 
characters (approximately a 
quarter of a page)

See page 111

Delete All 
AlphaWord 
Plus Files

Deletes all AlphaWord Plus 
files on your Neo, including 
workspace files and named 
files that aren’t in workspaces

This setting 
(Continued) Does this (Continued)

Additional information 
(Continued)
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For example, if you change the maximum file size setting to 82,000 
(roughly 40 pages), and the minimum file size to 2,000 (about a 
page), you might have only a handful of files that can reach full 
capacity. Other files are managed so that the minimum amount of 
space is reserved.

The maximum file size that you can set is 102,400 characters 
(50 pages or so); the minimum is 512 characters (about one quarter 
of a page.) When working with large files, you might notice some 
performance issues, depending on each device’s particular setup 
(number of SmartApplets installed, size and number of data files, 
and so on).

Tip! You can estimate page lengths by using a character count of 
2,048. A page is approximately 2,048 characters. The number is 
approximate because page length can be affected by printer and 
application settings on your computer.

Spell Check settings
Spell Check has its own settings that you can control through 
AlphaSmart Manager. These settings are listed in the following table.

Other SmartApplets settings
If you purchased other SmartApplets such as Beamer, Inspiration, or 
AlphaQuiz, they may have settings specific to them. You can check 
these settings the same way as for other SmartApplets. In 
AlphaSmart Manager, click the Settings tab, then select the 

This setting Does this

Disable this SmartApplet Prevents users from performing spell checks

Allow adding words to 
dictionary

Allows users to add words to the custom user 
dictionary

Delete user dictionary Deletes the custom user dictionary on all 
connected devices
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SmartApplet in the SmartApplet List. The specific settings, if they 
exist, will appear there.

You can also consult the documentation that came with the 
SmartApplet for more information.

Using Send Lists
A send list is what you use to transfer information from AlphaSmart 
Manager to your Neo. Changes you’ve made to AlphaWord files, to 
settings, to SmartApplets, and so on, appear in a send list before you 
actually transfer the changes to your Neo. 

You can make changes on the fly and send them over immediately, or 
you can create and save a send list with activities and changes you 
make regularly.

Note: Send lists are particularly useful with groups of Neos using 
an AlphaHub.
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To send changes without saving the send list:

1. In AlphaSmart Manager, make the changes that you want to send 
to your Neo.

2. Click the Send List tab and verify that the changes you want to 
make appear in the Send List Display.

3. Click Send.

To save changes in a send list:

1. In AlphaSmart Manager, make changes you want to send to 
your Neo.

2. Click the Send List tab and verify that the changes you want to 
make appear in the Send List Display.

3. Choose File > Save Send List.

4. Browse to specify the folder where you want to save the send list, 
type a name in the File Name field, then click Save.

5. Click Send to send the information to your Neo.

To open a saved send list:

1. In AlphaSmart Manager, choose File > Open Send List.

2. Browse to the folder where the saved send list is located.
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3. Select the send list you want to open. (Send lists use an .acf file 
extension.)

4. Click Open.

5. Click the Send List tab in AlphaSmart Manager to view the 
opened send list.

Passwords in AlphaSmart Manager
As explained in “Neo password protection” on page 77, there are 
three types of password protection for the Neo. AlphaSmart Manager 
lets you control all three types of passwords. 

Note: Passwords can be one to six characters long, can contain 
alphanumeric characters and symbols but not spaces, and aren’t 
case-sensitive.

Send list password 
When you set a send list password, no one can send information 
from AlphaSmart Manager to your Neo without first typing this 
password.

To set a send list password:

1. In AlphaSmart Manager, do one of the following:

• Macintosh: Choose AlphaSmart Manager > Preferences.

• PC: Choose Edit > Preferences.

2. Click Set Send Password.

3. Type the password in the New Password field, then retype it in 
the Retype Password field.

4. Click OK, then click OK again.
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Important: A send list password can only be set in AlphaSmart 
Manager. If you forget your send list password, contact Technical 
Support.

If you no longer want to use a send list password, you can clear it, as 
long as you know the current send list password.

To clear a send list password:

1. Do one of the following:

• Macintosh: Choose AlphaSmart Manager > Preferences.

• PC: Choose Edit > Preferences.

2. Click Set Send List Password.

3. Type the current password in the Old password field.

4. Leave the New password and Retype new password fields blank, 
then click OK.

Master password
A master password controls access to various settings (such as 
disabling and enabling SmartApplets on your Neo) and permits the 
ability to create individual file passwords for AlphaWord files. With 
Neo, you can set your own unique master password. It is 
recommended you do so for greater security.

To set a master password:

1. In AlphaSmart Manager, click the Settings tab.

2. Select System in the Settings List.

3. Scroll down until you see the Master Password setting.

4. Enter the text you want to use as the password. (Master 
passwords can be between one and six characters long.)
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5. Click the Send tab and verify that the setting appears in the 
send list.

6. Click Send.

Note: If you forget your master password, you can simply set a 
new one in AlphaSmart Manager by following the steps explained 
above.

File passwords
File passwords are useful for protecting the contents of your 
AlphaWord files. With AlphaSmart Manager, you can set a single 
password for all files, which you can later change to individual, 
unique file passwords on your Neo.

You can’t set individual file passwords without first enabling 
password protection.

To enable passwords and set a global file password:

1. In AlphaSmart Manager, click the Settings tab.

2. Select AlphaWord in the Settings List on the left.

3. Select the On option for Passwords Enabled; note that 
AlphaSmart Manager checks the Passwords Enabled checkbox. 
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4. Type a global file password in the File Passwords text box. 
(Passwords can be between one and six characters long.)

5. Click the Send tab and verify that the setting appears in the 
send list.

6. Click Send.

Sending a user dictionary to Neo
If your writing often contains words that aren’t in Neo’s spell check 
dictionary, you might want to create your own list of words—a 
custom user dictionary—and send it to your Neo.

You create a word list as a text file on your computer and send it to 
your Neo using AlphaSmart Manager. The following illustration 
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shows a sample user dictionary. You can separate words in a text file 
with spaces, commas, tabs, or carriage returns.

There can be only one custom user dictionary on an AlphaSmart 
device. If you want to make changes to the user dictionary—
additions or deletions—it’s best to make the change in the word list 
file on your computer and resend it to your Neo. Consequently, it’s a 
good idea to keep the user dictionary on your computer so that you 
can make changes to it as you need to. When you send a new list to 
your Neo, it overwrites the existing user dictionary on the device.

You can delete a user dictionary from the Spell Check settings either 
in AlphaSmart Manager or in Control Panel on your Neo.

SpiffyPro
Oban
Turlock
Cumbria
Bena
Caden
Ipswitch
Cupertino
Islay
MegaSync
Aptos
Surrey

A custom word list for a user 
dictionary; the words are 
separated by carriage returns 
in this example
ng with AlphaSmart Manager 119



120

Replacing the thesaurus with the Spanish-English word lookup
To send a user dictionary to your Neo:

1. Using a word-processing application on your computer, create a 
list of words and save the file as a text file with a .txt file 
extension in the name (for example, mywords.txt).

2. In AlphaSmart Manager, choose File > Send User Dictionary.

3. Browse to select the text file you created, then click Open.

4. Click the Send List tab and verify that your list of words appears 
in the SpellCheck Files area of the send list.

5. Click Send.

Replacing the thesaurus with the 
Spanish-English word lookup
If you’re not using the thesaurus that comes preinstalled on Neo, you 
can remove it and replace it with a Spanish-English word lookup 
utility. Only one of these utilities can be installed on Neo at a time; 
consequently, you need to remove one as you’re installing the other. 

To install the Spanish-English word lookup:

1. In AlphaSmart Manager, choose File > New Send List.

2. Click the SmartApplets tab and select Thesaurus-Spanish in the 
Install List, then click Add.

3. Do one of the following:

• Macintosh: Choose AlphaSmart Manager > Preferences.

• PC: Choose Edit > Preferences.
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4. Make sure the setting Replace SmartApplets on device with 
SmartApplets on computer is checked.

5. Click the Send List and verify that the word lookup appears and 
click Send.

AlphaSmart Manager removes the thesaurus and installs the word 
lookup.
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Other AlphaSmart Manager tasks
There are a handful of other tasks you can do in AlphaSmart 
Manager, such as set preferences, restore settings to factory defaults, 
reset or revert devices, view SmartApplet information, and more. 
These tasks are described in the AlphaSmart Manager User’s Guide, 
included in .pdf format on the CD that accompanied your Neo. 
Neo User’s Guide



Chapter 6

Troubleshooting
Troubl
This chapter describes some common difficulties and solutions with 
Neos. If you’re having a problem that you don’t see described here, 
consult the AlphaSmart web site or Technical Support.

Nothing appears on the Neo screen when I turn it on.

If the screen is blank except for a flashing cursor in the upper left 
corner of the screen, then you’re simply in an empty file. Start typing 
and characters should appear on your screen.

If your screen is completely blank without a flashing cursor, check 
your batteries by connecting your Neo to your computer with a USB 
cable. 

If the device turns on, the problem is likely due to one of the 
following:

• Your alkaline batteries need to be replaced.

• Your alkaline batteries were improperly inserted. Reinsert the 
batteries following the diagram inside the battery door.

• Your rechargeable battery pack was fully discharged and needs 
charging.
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When I attach my Neo to my computer, I can’t send any data, 
and my Neo screen shows a file instead of the “Attached 
to…” message.

Check these three things:

• Examine the cable connections—one may be loose.

• Plus your USB cable into a different USB port on your computer.

• Close AlphaSmart Manager, if it’s running. You can’t send text to 
an application on your computer when AlphaSmart Manager is 
running.

When I turn on my Neo, I see something other than the file 
that I expected.

Your Neo places you wherever you were last working when you 
turned the device off. If you were working in File 4 of AlphaWord Plus, 
it will place you in that file. If you were in Control Panel, it will place 
you in that SmartApplet. If you were working on calculations in 
Calculator, it will place you in Calculator with your last figures 
showing.

The exception to this behavior is when you’ve set a startup 
SmartApplet. When you designate a startup SmartApplet, that 
SmartApplet is the application that you see first each time you turn 
your Neo on.

If you’re in AlphaWord Plus, but not seeing the text you expect, make 
sure you’re in the correct file. To change files, press file 1 to go to 
File 1, file 2 to go to File 2, and so on, or use the File Selector or 
Open File.
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When I send a file to my computer, some of the characters 
don’t show up.

This is likely a problem with the speed with which the Neo is sending 
the data. Try these measures to solve the problem:

• Disconnect Neo from the computer and check the file transfer 
speed by pressing option- -S. Reset Neo to a slower setting 
(speed 1 is the slowest).

• Try using a different word processing application on your 
computer. Some applications allow faster data transfer than 
others. If this solves the problem, you can copy and paste the text 
back into your original application. 

• Adjust keyboard settings on your computer, experimenting with 
the key repeat rate and the repeat delay rate. (On a Macintosh, 
adjust hardware settings in System Preferences; on a PC, adjust 
keyboard settings in Control Panel.) 

I try to type in a file, but no characters appear.

You might have the Slow Keys setting turned on. You can change the 
setting in one of three ways:

• Press ctrl-option- -K and adjust the time delay. See “Slow Keys” 
on page 75.

• On your Neo, press applets and choose the Control Panel 
SmartApplet. Then step through the settings to change to the 
keyboard settings you want.

• In AlphaSmart Manager, select a Slow Keys setting from the 
Settings tab. See page 108 for more information.
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My file (or the end of my file) is filled with garbage 
characters.

There are three ways you can deal with this situation:

• If you have no useful text in the file, just press clear file to remove 
the entire file.

• If you have some data you would like to save, place the cursor 
where the garbage characters start, press shift-end to select the 
garbage characters, then press delete. 

• Send the file to your computer and cancel the transfer when 
garbage characters appear.

When I transfer text to my PC, the case of the characters is 
reversed; all the lowercase characters show up as uppercase, 
and the uppercase characters show up as lowercase.

It’s likely that the Caps Lock key on your computer was on when you 
sent the text from Neo. Press Caps Lock on your computer keyboard 
to turn it off, and then resend the file.

When I press a key, the wrong letter appears on the screen. 

It’s likely that your Neo is using a different keyboard layout. You can 
change the keyboard layout in one of three ways:

• Press option- -L and select a layout. See “Keyboard layouts” on 
page 72.

• On your Neo, press applets and choose the Control Panel 
SmartApplet. Then step through the settings to change to the 
keyboard layout you want.

• In AlphaSmart Manager, select a layout from the Settings tab. 
See page 108 for more information.
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My LCD screen broke. Is it covered under warranty? What 
should I do?

If the device malfunctions during the warranty period, repairs are 
covered. However, a broken LCD screen is not considered a 
malfunction and is therefore not covered under warranty. AlphaSmart 
can replace the LCD screen; contact Technical Support for pricing 
information and a Return Material Authorization number.

Do I need antivirus software for my Neo?

Antivirus software isn’t needed for your Neo.

What should I do if I spill something on my Neo?

If the spill is water, follow these steps:

1. Remove all power sources (batteries, USB cable, AC adapter, 
rechargeable battery pack).

2. Dry the device using a canned air dusting product or hair dryer 
(on air only or low heat setting).

3. When the device is dry, reconnect the power sources and try 
turning the unit on.

4. If the unit doesn’t turn on or malfunctions, contact Technical 
Support.

If the spill is something other than water, contact Technical Support 
immediately for assistance. Don’t let the unit sit for an extended 
period before consulting Technical Support. The cleanup measures 
that Technical Support will suggest aren’t likely to work if you don’t 
deal with the spill soon after it occurs.
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When I use Kid Works and Student Writing Center on my 
computer, I can’t seem to send text from my Neo.

With graphics intensive programs such as these, you need to use the 
slowest transfer speed. Change the transfer speed by following the 
instructions on page 84 and choosing Very Slow (1). 

If you still lose data sending to Kid Works 2, turn Sound Effects off by 
deselecting it under the Kid Works 2 Options menu.
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Understanding Batteries
Under
This appendix contains technical information about batteries for your 
Neo. It explains

• Power sources for the Neo

• Alkaline batteries

• Rechargeable batteries

• The low battery indicator

• Tips on caring for batteries and storing your Neo

Powering your Neo
In order to use your Neo, it must have power, of course. Depending 
on the model you chose, Neo uses three AA batteries that you insert 
and maintain, or it uses internal rechargeable batteries 
(a rechargeable pack specifically designed for AlphaSmart devices). 

With AA batteries, all the batteries need to be the same type. Alkaline 
batteries are recommended. With rechargeable batteries, you 
recharge the device with its included AC adapter.

Your Neo can be powered by your computer when connected to it 
with a USB cable. When connected, however, Neo acts as the 
computer’s keyboard rather than a standalone device.

If you have a Neo that uses AA batteries and you want to use 
rechargeable batteries instead, you can purchase a rechargeable 
battery upgrade kit (see the AlphaSmart web site for details). You 
install the kit yourself to convert your device from alkaline batteries. 
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Alkaline batteries
Refer to “Internal rechargeable batteries” on page 131 for additional 
information.

Auto Power-On
Neo turns on automatically when you connect it to

• A powered-on AlphaHub (usually in a classroom situation) with 
its supplied USB cable

• A powered-on computer with a USB cable 

Neo remains on until the cable is disconnected or the AlphaHub or 
computer is turned off. When the cable is disconnected or power is 
removed from the cable, Neo returns to the state it was in before 
connecting. That is, if it was off before connecting, it will turn off 
again when disconnected.

When connected to a computer with a USB cable, Neo uses the 
power available from the computer, even if no batteries are installed. 
When Neo is connected to a computer, don’t connect the AC adapter; 
it’s not necessary.

Alkaline batteries
Neo runs on three AA alkaline batteries or internal rechargeable 
batteries. Of the disposable battery types, alkaline batteries provide 
the longest battery life, particularly if they are of good quality. 
Typically, alkaline batteries can provide power to the Neo for up to 
700 hours, or more. 

Replacing AA batteries
When replacing batteries, you must change all three batteries. If one 
discharged AA battery is used with two new batteries, the battery life 
is markedly reduced, even though two out of the three are new. 
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To replace AA batteries:

1. Turn your Neo over and locate the battery compartment.

2. Use a Phillips-head screwdriver to remove the screw.

3. Open the battery door by placing your thumbs in the depressions 
on the ends of the latch, then gently press down and slide the 
latch to the left.

4. Remove the old batteries

5. Insert the new batteries with the (+) terminals pointing to the 
right and the (–) terminals pointing to the left.

6. Replace the latch and slide it gently to the right.

7. Replace the screw.

Internal rechargeable batteries
If you have a rechargeable Neo, the batteries in the battery pack are 
automatically recharged whenever the AC adapter is plugged in, or 
when your Neo is connected to a powered-on computer with a USB 
cable or to an AlphaHub. The batteries charge regardless of whether 
Neo is off or on.

Important: If you’re going to store your Neo for a month or longer, 
charge it before you store it, and then again after you take it out of 
storage to compensate for the batteries’ self discharge. 
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The AC adapter

A rechargeable Neo comes with an AC adapter for charging the 
internal batteries. The specifications for the adapter are listed here:

• Class 2 transformer

• Input: AC 120V 60Hz 9W (US) or 230V 50Hz 11.5W (UK and 
Europe)

• Output: DC 7.5V 500 MA

You should always use the AC adapter supplied by AlphaSmart; don’t 
use other types. 

Charging a rechargeable device
Neo’s rechargeable batteries use Nickel Metal Hydride (NiMH) cells. 
NiMH cells can be charged about 500 times. Fully charged batteries 
can power the Neo for 60–150 hours (or even much longer), 
depending on use. (Note, however, that fully charged batteries that 
are never used lose their charge in about a month due to the self-
discharge effect.)

New NiMH batteries need to be “cycled”—also known as 
“conditioned”—three to five times before they hold a full charge. This 
means that, during the first three to five charge cycles, the batteries 
hold a successively better charge each time until they reach full 
capacity.

To charge the batteries:

X Plug the AC adapter into a working electrical outlet and connect it 
to the power port on the left side of your Neo.

+ (Positive)– (Negative)
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To condition the batteries:

1. Fully charge your Neo with the AC adapter.

2. Use your Neo without the AC adapter until the low battery 
message appears. (This may take 60–150 hours of use.) 

3. Repeat steps 1 and 2 three to five times.

You’ll get the longest life from your batteries if you wait for the low 
battery warning to appear onscreen so the batteries aren’t needlessly 
recharged. Charging with the AC adapter for about 8–16 hours fully 
charges it; if you charge it with an AlphaHub or USB cable, it may 
take as long as 24 hours. Don’t, however, charge the batteries for 
more than a week. Doing so may damage the batteries. 

Neo’s indicator light turns green when the device is fully charged.

Storing and recharging Neos

Rechargeable batteries that aren’t used over time “self discharge.” 
That is, they lose their charge and need to be fully charged again 
before being used. 

If the batteries self discharge too much while in storage (which can 
happen if you store your Neo for longer than you intended), the 
batteries themselves may become damaged, which in turn can 
damage the device. 

Important: If you’re going to store your Neo for a month or longer, 
charge it before you store it, and then again after you take it out of 
storage to compensate for the batteries’ self discharge. 

Lifetime of the rechargeable batteries

AlphaSmart rechargeable batteries last a long time, but they don’t 
last forever. Well-maintained rechargeable batteries last about 500 
charges, or about three years. If your batteries used to last forty hours 
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but now last only one hour, you need a new battery pack, which you 
can purchase from AlphaSmart.

Note: If your batteries have run down, and you don’t have an AC 
adapter, you can still send your data from your Neo to your 
computer while the batteries are charging. Simply attach Neo to 
your computer and turn it on. The cable supplies power to Neo 
from the computer. You can’t do any editing, but you can transfer 
the data in your files.

Toxic elements statement

Each battery cell is a sealed container enclosing a nickel electrode 
and a potassium hydroxide electrolyte. The electrolyte is caustic. 
Avoid contact with skin or eyes. If exposed accidentally, flush eyes 
with water immediately.

Warning! Do not incinerate or mutilate the battery, as this may cause 
it to burst or release toxic materials. Do not short circuit, as this may 
cause burns. Please dispose of in accordance with local, state, and 
federal regulations.

Low battery indicator
When your AA batteries or rechargeable batteries are getting low, a 
warning message appears onscreen.

The message appears about eight hours before your AA batteries are 
dead and about twenty minutes before your rechargeable batteries 
are dead.

Checking battery status
If you’re curious about how much power is left in your Neo, you can 
check the battery status at any time.
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Low battery indicator
To check battery status:

1. Press ctrl- -B. The display shows a picture representing the 
amount of battery power left and a message showing the 
percentage.

2. Press any key to return to your file.

Tips on caring for batteries
• To avoid battery leakage in AA batteries, change the batteries as 

soon as they become weak.

• Do not drop, puncture, disassemble, mutilate, or incinerate the 
batteries.

• Do not leave batteries in hot locations.

• When storing rechargeable Neos for several months, fully charge 
them before placing them in storage to avoid damaging the 
batteries. Fully charge them again when you take them out of 
storage.

Lithium battery
Neo contains a secondary backup battery that isn’t intended to be 
accessed by users. The lithium battery provides power to the memory 
and prevents data loss when the unit is turned off or when the 
batteries are dead or removed. The lithium battery will last 
approximately five to seven years. If you suspect a problem with the 
lithium battery, visit the AlphaSmart web site for more information or 
contact Technical Support for assistance. 
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Low battery indicator
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Keyboard Commands and
Special Characters
Keybo
This appendix provides lists of keyboard commands and 
information and tables that show you how to enter international 
and special characters using your Neo.

Keyboard commands

Action Keyboard command

Move one character left or right I J

Move up or down one line K L

Move up one screen (scrolling) -K

Move down one screen 
(scrolling)

-L

Move to beginning of line -I

Move to end of line -J

Move to beginning of file home

Move to end of file end

Move to previous word option-I

Move to next word option-J

Move to previous sentence ctrl-I

Move to next sentence ctrl-J

Move to previous paragraph ctrl-K

Move to next paragraph ctrl-L
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Select/deselect one character to 
the left

shift-I

Select/deselect one character to 
the right

shift-J

Select/deselect one line up shift-K

Select/deselect one line down shift-L

Select from cursor to beginning 
of word

shift-option-I

Select from cursor to end of 
word

shift-option-J

Select from cursor to beginning 
of line

shift- -I

Select from cursor to end of line shift- -J

Select all (select entire file) ctrl-A or -A

Cut selected text to clipboard ctrl-X or -X

Copy selected text to clipboard ctrl-C or -C

Paste text from clipboard ctrl-V or -V

Delete a character or selection 
to the left of the cursor

backspace

Delete a character or selection 
to the right of the cursor

delete or

ctrl-backspace

Clear the entire contents of the 
file

clear file

Clear the contents from all eight 
workspace files

shift-ctrl-option- -clear file

Permanently delete an entire 
file

option- -clear file

Permanently delete all files ctrl-option- -clear file

Action Keyboard command
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Keyboard commands
Recover 40 characters ctrl-option- -R

Recover file from last deletion option- -R

Recover entire file ctrl-shift-option- -R

Find text Find or -F

Find again -G

Find and replace ctrl-find

Check spelling spell check

Spell check word containing 
cursor

-spell check

Spell check on/off option- -spell check

Spell check a selected section ctrl-spell check

Ignore all occurrences in spell 
check

ctrl-I

Replace all in spell check ctrl-enter

Open thesaurus ctrl-T

File status (characters) ctrl- -I

File status (pages) -I

File statistics (number of words, 
characters, paragraphs, and 
spaces in a file)

ctrl-option- -I

Number of characters in all files shift-ctrl- -I

Number of pages in all files shift- -I

Word count (characters, words, 
paragraphs, pages)

ctrl-W

System details option- -V

Clipboard contents ctrl-option- -C

Action Keyboard command
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Keyboard commands
Clipboard status (characters) ctrl-shift-option- -C

Clipboard status (pages) option- -C

Print files print or -P

Typing Timer -find

Create new file ctrl-N

Open file ctrl-O

Save and name a file ctrl-S

Select file ctrl-F

Delete file ctrl-D

Send current AlphaWord Plus 
file to another Neo with Beamer

ctrl-send

Receive an AlphaWord Plus file 
from another Neo with Beamer

ctrl-B

Go to SmartApplets menu applets

Set a startup SmartApplet from 
the SmartApplets menu

ctrl-applets

Disable a SmartApplet from the 
SmartApplets menu

ctrl- -L

Display information about 
selected SmartApplet 

option-applets

Select font size ctrl-option- -F

Copy linked file to clipboard shift-ctrl- -C

Copy current screen of a linked 
file

shift-ctrl-C

Select section -S

View linked file/main file ctrl-L

Action Keyboard command
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Password enable/disable 
(master password required)

ctrl-option- -P

Change file password option- -P

Enable/disable Calculator 
(master password required)

ctrl- -C

Sticky Keys, Auto Repeat, 
Show Marks status

option- -K

Slow Keys status ctrl-option- -K

Change keyboard layout 
(QWERTY, Dvorak, Right, Left)

option- -L

Change send speed (cable) option- -S

Change send speed (IR) ctrl-option- -S

Switch to another file (when 
connected by USB) 

-File 1(File 2, File 3, and so 
on)

Check battery status ctrl- -B

Set idle time option- -T

View help contents ctrl-H or -H

Copy help contents ctrl-C

View system hardware details ctrl-shift-option- -I

View system software details ctrl-shift-option- -B

Action Keyboard command
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International and special characters
International and special characters
The following tables show the international and special characters 
that Neo supports and the keyboard combination required to 
generate each character. 

Keyboard combinations separated by hyphens (ctrl-option-2, for 
example) should be pressed in the order given and held down until 
the last key is pressed. 

Keyboard combinations separated by a comma (for example, 
option-E, A) should be pressed sequentially; in this example, press 
and hold the option key while pressing E, then release them both 
before pressing A. You will not see a character displayed after 
pressing the E, but the character that appears after pressing the A 
will be an accented lowercase a. 

Character Keystroke(s) Notes

Á option-E, shift-A acute accent

À option-`, shift-A grave accent

Ä option-U, shift-A umlaut accent

Ã option-N, shift-A tilde accent

Å option-shift-A dot accent

á option-E, A acute accent

à option-`, A grave accent

â option-I, A circumflex accent

ä option-U, A umlaut accent

ã option-N, A tilde accent

å option-A dot accent

æ option-' digraph (ligature)

Æ option-shift-' digraph (ligature)
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International and special characters
ç option-C cedilla accent

Ç option-shift-C cedilla accent

É option-E, shift-E acute accent

È option-`, shift-E grave accent

Ê option-I, shift-E circumflex accent

Ë option-U, shift-E umlaut accent

è option-`, E grave accent

ê option-I, E circumflex accent

ë option-U, E umlaut accent

í option-E, I acute accent

ì option-`, I grave accent

î option-I, I circumflex accent

ï option-U, I umlaut accent

Ñ option-N, shift-N tilde accent

ñ option-N, N tilde accent

Ó option-E, shift-O acute accent

Ò option-`, shift-O grave accent

Ô option-I, shift-O circumflex accent

Ö option-U, shift-O umlaut accent

Õ option-N, shift-O tilde accent

ó option-E, O acute accent

ò option-`, O grave accent

ô option-I, O circumflex accent

ö option-U, O umlaut accent

õ option-N, O tilde accent

Character Keystroke(s) Notes
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International and special characters
Ú option-E, shift-U acute accent

Ù option-`, shift-U grave accent

Û option-I, shift-U circumflex accent

Ü option-U, shift-U umlaut accent

ú option-E, U acute accent

ù option-`, U grave accent

û option-I, U circumflex accent

ü option-U, U umlaut accent

ÿ option-U, Y umlaut accent

Character Keystroke(s)

™ option-2

® option-R

© option-G

ø option-O

Ø option-shift-O

° option-shift-8

 (infinity) option-5

§ option-6

¶ option-7

¿ option-shift-/

¡ option-1

» option-shift-\

« option-\

´ (acute accent) option-E, space

Character Keystroke(s) Notes

∞
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International and special characters
` (grave accent) option-`, space

^ (circumflex) option-I, space

¨ (umlaut) option-U, space

~ (tilde) option-N, space
. (superscript dot) option-H

ctrl-option-2

ctrl-option-3

ctrl-option-4

÷ option-/

± option-shift-=

ƒ option-F

$ shift-4

¢ option-4

£ option-3

¤ option-shift-5

¥ option-Y

option-shift-2

ß (beta or German Sharp S) option-S

(sigma) option-W

 (pi) option-P

µ (mu) option-M

 (omega) option-Z

Character Keystroke(s)

Σ

π

Ω
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Troubleshooting special characters
International characters are supported by both Macintosh and 
Windows computers. Some Windows applications don’t support the 
Microsoft international character set and may have problems 
correctly displaying international characters. If characters haven’t 
transferred correctly to a particular Windows application, you can try 
the workaround described here.

To transfer international characters to problematic Windows 
applications:

1. On your computer, open the Notepad application.

2. On your Neo, send your text to Notepad. 

3. In Notepad, select all the text, then press Ctrl-C to copy it to the 
Windows clipboard. 

4. Open a new file in the application that didn’t accept the special 
characters earlier.

5. Paste the text into a document in that application.

Copying and pasting through the clipboard usually solves the 
problem because the clipboard performs the appropriate 
translations.
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Warranty, Maintenance, and
Contact Information
Warra
This appendix explains various topics:

• Warranty information

• The AlphaSmart guarantee 

• Maintenance tips for your Neo

• Contact information and return procedures

• FCC statement

Warranty
AlphaSmart, Inc., warrants the Neo keyboard and display to be free 
from defects in materials and workmanship for a period of three years 
from the date of original purchase.

For rechargeable devices, AlphaSmart, Inc., warrants the rechargeable 
battery to be free from defects for 90 days from the date of original 
purchase.

During this period, if a defect occurs, AlphaSmart, Inc., will, at its 
option, repair or replace your Neo at no charge to you, provided that 
it is returned during the warranty period to AlphaSmart, Inc., or one 
of its authorized resellers. This warranty does not apply if your Neo 
has been damaged by accident or abuse, modified without the 
written permission of AlphaSmart, Inc., or if identifying marks 
(including serial numbers) or seals have been removed or defaced.
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Guarantee
There are no other warranties, expressed or implied. AlphaSmart, 
Inc., accepts no responsibility for consequential damages, including, 
but not limited to, loss of profit or benefits.

Guarantee
AlphaSmart, Inc., will refund your money in full (less original 
shipping charges) if the items are returned in original condition 
within thirty days of customer receipt of items.

Maintenance tips
With proper care and maintenance, your Neo will last for a long time. 
The following tips help keep your Neo in top condition:

• Always turn off your Neo before changing the batteries.

• Take care not to break the LCD screen. Don’t drop Neo or subject 
it to strong impact. Don’t place an AC adapter or other heavy 
object over the LCD screen.

• Clean the screen only with a soft dry cloth. Don’t use solvents.

• Keep your Neo away from extreme heat. Don’t leave it on the 
dashboard, in the trunk of a car, or near a heater.

• Don’t leave your Neo in a place that is extremely dusty or damp.

• Don’t use frayed or damaged cables.

• Never force a connector into a port if the connector and port do 
not join easily.

Storing your Neo
If you know you’re not going to be using your Neo for awhile, follow 
these guidelines:
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Maintenance tips
• If you’re storing a Neo that uses alkaline batteries, and you’re 
going to be storing it for longer than six months, or the battery 
capacity is less than 20%, remove the batteries from the device.

• If you’re storing a rechargeable Neo for between one and six 
months, charge the device before you store it, and again after you 
take it out of storage (to compensate for the battery pack’s self 
discharge). 

• Just as for a single Neo, if you’re storing a group of rechargeable 
Neos, be sure to charge all of them before you store them, and 
then again after you take them out of storage.

• Use care when storing or stacking a group of Neos. You may 
inadvertently cause a power drain from some units if they are 
stored incorrectly. If several Neos are stacked on top of each 
other and offset somewhat, be careful that the rubber foot on the 
bottom of any of the units does not touch the on/off key on the 
top of any other units. If this occurs, the steady depression of the 
on/off key causes a small but constant battery power drain, even 
though nothing may appear on the screen. 

To avoid this potential problem, stack your Neos on edge or 
carefully make sure they’re are stacked vertically with no offset. 
You might want to enable the Two-button On option; see
“Two-button On setting” on page 68.
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Contact information
Contact information
The AlphaSmart web site is a good source of information about 
products, sales, support, community forums, and latest news. Visit 
the AlphaSmart web site at

www.alphasmart.com (United States)

www.alphasmart.co.uk (United Kingdom)

www.alphasmart.com/international (all other countries)

If you can’t find the information you’re looking for on the web site, 
use the contact information listed in this appendix.

United States

Technical questions or 
problems:

Phone: (530) 528-7200 

Email: support@alphasmart.com

Web: www.alphasmart.com/supportinfo

Purchase AlphaSmart products: Online store: www.alphasmart.com 

Phone: (888) 274-0680

General information or sales 
questions:

Phone: (888) 274-0680 

Email: info@alphasmart.com
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Contact information
 

United Kingdom

Technical questions or 
problems:

Phone: 0870 120 0718

Email: UK-help@alphasmart.com

Latest support information: www.alphasmart.co.uk/support

Purchase AlphaSmart products: www.alphasmart.co.uk/ordering

(This URL also provides a list of resellers and 
AlphaSmart contacts.)

Europe, Middle East, and Africa

Technical questions or 
problems:

Phone: +44 870 120 0718

Email: UK-help@alphasmart.com

Latest support information: www.alphasmart.com/supportinfo

Select your country or region.

Purchase AlphaSmart products: www.alphasmart.com/international

(This URL also provides a list of resellers and 
AlphaSmart contacts.)

Asia/Pacific, Canada, Latin America

Technical questions or 
problems:

Contact your local reseller. If you do not have a 
local reseller, email Technical Support at 
support@alphasmart.com.

Latest support information: www.alphasmart.com/supportinfo 

Select your country or region.

Purchase AlphaSmart products: www.alphasmart.com/international

(This URL also provides a list of resellers and 
AlphaSmart contacts.)
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Return procedures

Important: If you’re a customer outside the United States or United 
Kingdom, and you purchased your Neo from a reseller, then you 
should contact that reseller for assistance with your Neo. Do not 
return the device to AlphaSmart.

If you bought your Neo direct from AlphaSmart outside the United 
States or United Kingdom, contact the technical support resource 
listed for your region on page 151.

If you have a problem with your Neo, first read the section 
“Troubleshooting” on page 123. If this section doesn’t help you solve 
your problems, follow these steps for help.

1. Contact Technical Support using the contact information for your 
country listed on page 150. Eighty percent of all problems can be 
solved by email or over the phone.

2. If the device does need to be returned to the factory for repair, it 
must be assigned an RMA (Return Material Authorization) 
number in order to track the unit before it is returned. To receive 
an RMA number, contact Technical Support using the contact 
information for your country listed on page 150. You’ll need to 
provide the following information:

a. A detailed description of the problem

b. The serial number of the device

c. Your name and the address where the device should be 
returned

Note: Only AlphaSmart, Inc. can assign RMA numbers. If a Neo is 
returned without an RMA number, it will delay the repair and 
increase the chance that it could become lost. 
Neo User’s Guide



Warra

FCC statement
3. Write the RMA number on the outside and inside of the box. Also 
on the inside, tape a short, detailed note to the Neo explaining 
the problem (include the RMA number).

4. Ship the damaged Neo to the address given when you receive 
your RMA number. You will be sending your Neo to a repair 
center, not to the AlphaSmart, Inc., office.

Important: Please ship Neo with a reliable shipper. AlphaSmart, Inc., 
will not be held responsible for devices that are lost in shipment 
from a customer, or that are returned without an RMA number.

Your repaired Neo will be returned to you within two weeks of receipt. 
If damages are due to accident or abuse, you’ll be charged a fee for 
the parts replaced, as well as a repair handling fee.

FCC statement
Note: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 
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• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for 
help.

FCC caution
Any changes or modifications not expressly approved by AlphaSmart 
could void the user's authority to operate the equipment. This device 
complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.
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Index
A
AA batteries 6, 129

adding words to user dictionary 112

alkaline batteries 129

AlphaBeam 17

AlphaSmart Manager 87

described 87

installing 14

passwords in 115

printing files 91, 94

saving files 91, 98

sending files 99

starting 89

viewing files 91

AlphaWord Plus 21, 61

defined 61

settings 67, 110

antonyms 41

auto power-on 130

Auto Repeat setting 76, 106

B
basics of AlphaSmart Manager 87

batteries 5, 134

caring for 135

charging 6

checking status 134

installing AA batteries 6

lithium 135

rechargeable 5

rechargeable upgrade kit 129

replacing 130

status 71

status indicator 134

understanding 129

Beamer 18

beaming

AlphaWord Plus files 

between Neos 18

sending text 12

text to printer 14

black light 91

blank screen 7, 123

broken LCD screen 127

C
cable (see USB cable)

Calculator 61

paper tape 63

turning off 64

changing

font size 28

keyboard layout 72

passwords 80

transfer speed 84
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characters

counting 43

international 142

missing 125

special 137, 142

charging batteries 6, 132

checkboxes in linked files 50

checking

battery status 134

file size 53

spelling 36

clearing workspace files 54, 56

clipboard 24

contents 24

status 24

commands, keyboard 137

connecting Neo to your computer 9

connection status 90

contact information 150

contents of clipboard 24

Control Panel 64

setting options 66

settings 65

copying text 23

counting characters, words,

paragraphs, pages 43

creating

files 25

linked files 46

cursor, moving 22

custom dictionary 39

sending to Neo 118

cutting text 23

D
data, recovering 58

defining

section separations 35

settings 105

deleting

files 54, 57

text 23

user dictionary 112

dictionary, user 39, 118

disabled setting 110

disabling spell check 38

display battery status 71

Dvorak layout 72

E
editing files 26

empty files, sending 101

English-Spanish word lookup 42

entering special characters 69

entering text 21

extra large font 29

F
file

length 44

maximum/minimum sizes 111

passwords 77, 79, 117

size 111

File Selector 26
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files 25

capacity 52

checking file size 53

clearing and deleting 54

clearing workspaces 56

creating 25

deleting 57

editing 26

linked 45

maintaining 52

naming and saving 26

printing in AlphaSmart Manager 94

reaching capacity in 53

saving in AlphaSmart Manager 98

sending empty files 101

sending from 

AlphaSmart Manager 99

sizes 52

switching 11

finding

replacing text 33

text 31

tips for searching 34

fixed-width font 30

font size

changing 28

reset to system 106

setting 30

formatting text 28

formulas with Calculator 62

full file 53

G
garbage characters 126

Get Utility 17

green light 91

guarantee 148

H
hidden SmartApplets 105

I
idle time 106

installing

AA batteries 6

AlphaSmart Manager 14

SmartApplets 102

Spanish-English word lookup 120

international characters 142

IR beaming 12

IR transfer speed 106

K
keyboard

alternate layouts 72, 77

commands 137

layout 69, 71, 106

settings 71

viewing layout 70

keyboarding timer 81

L
large font 28

launching AlphaSmart Manager 89

LCD screen 127

left hand only layout 72, 74

length of a file 44
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linked files 45

creating 46

sample 51

sending 47

tags 50

viewing 49

lithium battery 135

lookup Spanish words 42

low battery indicator 134

M
maintaining files 52

maintenance tips 148

master password 77, 107, 116

match case replace option 33

maximum file size 111

medium font 28

memory column 102

missing characters 125

monospaced font 30

moving the cursor 22

N
naming files 26

Neo

powering 129

storing 148

storing and recharging 133

O
onscreen, viewing keyboard layouts 70

opening files 27

opening send lists 114

operands in Calculator 62

P
page counts 43

paper tape in Calculator 63

paragraph counts 43

password protection 78

passwords 77

default file 80

file 117

in AlphaSmart Manager 115

master password 116

resetting 80

send list 115

setting 79

pasting text 23

power 5

auto power-on 130, 132

powering Neo 129

printing

by beaming 14

files in AlphaSmart Manager 94

text 14

to USB printer 14

procedures for return 152

proportional font 30

Q
QWERTY layout 72

R
rechargeable batteries, charging 132

rechargeable battery upgrade kit 129

recharging Neo 133

recovering data 58

Replace All option 33
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replacing

batteries 130

text 33

requirements, system 3

reset system font 106

return procedures 152

right hand only layout 72

RMA number 152

rubrics 45

S
safety 147

saving

files 26

files in AlphaSmart Manager 98

send lists 114

screen

blank 7, 123

broken LCD 127

changing font size 28

viewing keyboard layouts 70

Screen Contrast setting 69

searching

text 31

within all files 32

section selector 35

sections, defining separations 35

selecting

sections 35

text 23

self discharge effect 133

send lists 88, 113

opening 114

password 77, 115

saving 114

sending

empty files 101

files to Neo from 

AlphaSmart Manager 99

linked files 47

text by beaming 12

text by cable 10

text to a computer 10

text to applications 83

user dictionary 118

with AlphaSmart Manager 88

separations for sections 35

setting

font size 30

options in Control Panel 66

passwords 79

settings

AlphaWord Plus 67, 110

Auto Repeat 76

Control Panel 65

defining 105

disabled setting 110

for SmartApplets 108

keyboard 71

keyboard layouts 69

Reset System Font 106

Screen Contrast 69

Show Marks 68

Slow Keys 75

spell check 67, 112

Sticky Keys 76

system 106

Two-button On 68

Show Marks setting 68

size of files 52, 111

checking 53
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Slow Keys setting 71, 75, 106, 125

small font 28

SmartApplets

AlphaWord Plus 61

Beamer 18

Calculator 61

Control Panel 64

defined 59

hidden 105

installing 102

settings 108

startup 108

space for files 52

Spanish-English word lookup 42

installing 120

special characters 69, 70, 137, 142

speed of transfers 84

spell check 36, 37

disabling 39

settings 67, 112

turning off or disabling 38

user dictionary 39, 118

spills 127

spreadsheet, sending text 83

starting AlphaSmart Manager 89

startup SmartApplet 106, 108

status

clipboard 24

connection in 

AlphaSmart Manager 90

of batteries 71, 134

of system 81

Status Screen 81

Sticky Keys setting 71, 76, 106

storing Neo 133, 148

switching files 11

system

font 28, 30

requirements 3

settings 106

status 81

T
tab characters 28

tags for linked files 50

text

cut/copy/paste/delete 23

entering and editing 21

finding 31

formatting 28

printing 14

replacing 33

searching 31

selecting 23

sending by beaming 12

sending by cable 10

sending to a computer 10

sending to a spreadsheet 83

thesaurus 40

antonyms 41

replacing with Spanish-English 

lookup 42

timing your typing 81

tips

for spell checks 38

for working with applications 83

maintenance 148

on finding text 34

toxic elements statement 134

transfer speed 84, 106
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turning off

Calculator 64

spell check 38

Two-button On setting 68, 107

Typing Timer 81

U
understanding batteries 129

upgrade kit, recharageable battery 129

USB cable 9

connecting Neo to your computer 9

providing power 129

sending text 10

USB connection 9

USB printer 14

user dictionary 39, 67, 118

add words to 112

deleting 112

sending to Neo 118

V
variable font size 28

very large font 29

viewing

clipboard contents/status 24

file length 44

keyboard layouts 69

linked files 49

W
warranty 147

Whole Word Replace option 33

word counts 43

word lookup (Spanish-English) 42

installing 120

working with files 28

workspaces 25

clearing all files 56

Y
yellow light 91
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